Unit 1

NET Framework & Language Constructs




Introduction to .NET Framework

.NET is a software framework which is designed and developed by
Microsoft.

first version of the .Net framework was 1.0 which came in the year 2002.
and the current version is 4.7.1.

In easy words, it is a virtual machine for compiling and executing programs
written in different languages like C#, VB.Net etc.

used to develop Windows Form-based applications, Web-based
applications, and Web services.

VB.Net and C# being the most common ones.
It is used to build applications for Windows, phone, web, etc.

NET is not a language (Runtime and a library for writing and executing
written programs in any compliant language)



Introduction to .NET Framework

e NET Framework supports more than 60 programming
languages in which 11 are designed and developed by
Microsoft,

e Some of them includes:
o CH#.NET
o VB.NET
o C++.NET
o JHE.NET
o F#.NET
o JSCRIPT.NET
o WINDOWS POWERSHELL




Framework, Languages, And Tools
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The .NET Framework

e Common Language Runtime
e Windows” Forms

o ASP.NET

> Web Forms
> Web Services

» ADO.NET, evolution of ADO
e Visual Studio.NET




Common Language Runtime (CLR)

*CLR works like a virtual machine in executing all languages.
oAll .NET languages must obey the rules and standards imposed
by CLR. Examples:

> QObject declaration, creation and use

o Data Types, language libraries

> Error and exception handling

> Interactive Development Environment (IDE)




Common Language Runtime(CLR)

e Development
> Mixed language applications

Common Language Specification (CLS)

Common Type System (CTS)
Standard class framework
Automatic memory management

o Consistent error handling and safer execution
o Potentially multi-platform

» Deployment
> Removal of registration dependency
o Safety — fewer versioning problems



Common Language Runtime

e CTS is a rich type system built into the CLR
— Implements various types (int, double, etc)
— And operations on those types

e CLS is a set of specifications that language and library
designers need to follow

— This will ensure interoperability between languages




Compilation and Execution of .NET Application




Compilation and Execution of .NET Application

* Any code written in any .NET complaint languages when compiled,
converts into MSIL (Microsoft Intermediate Language) code in form of an
assembly through CLS, CTS.

* |Lis the language that CLR can understand.

» On execution, this IL is converted into binary code(machine code) by
CLR’s just in time compiler (JIT) and these assemblies or DLL are loaded
into the memory.

 Compilation can be done with Debug or Release configuration. The
difference between these two is that in the debug configuration, only an
assembly is generated without optimization. However, in release
complete optimization is performed without debug symbols.




Basic Languages constructs

e Data Types

 Variables

e Conditional Statements

e Looping Statements

e Array

e Functions

» Class, Object, Methods, Properties
* Inheritance, Polymorphism




Lets Get Started

» Before we begin, download visual studio 2019
* Here is the download link



https://visualstudio.microsoft.com/downloads/

CH# Overview

e C#t is general-purpose, object-oriented programming language
developed by Microsoft.

e C#is designed for Common Language Infrastructure (CLI), which
consists of the executable code and runtime environment that
allows use of various high-level languages on different computer

platforms and architectures.
e Reasons - C# a widely used professional language:
° |t is object oriented & structured language
° |t is component oriented.
o |t is easy to learn & produces efficient programs.

° |t can be compiled on a variety of computer platforms.
o a part of .Net Framework.



Strong Programming Features of C#

e Boolean Conditions

e Automatic Garbage Collection
e Standard Library

e Assembly Versioning

e Properties and Events

e Delegates and Events Management
e Easy-to-use Generics

e Indexers

e Conditional Compilation

e Simple Multithreading

e LINQ and Lambda Expressions
e [ntegration with Windows




C# Program Structure

namespace ConsoleApplicationl

{

class Program

{
static void Main(string[] args)

{




C# - Program.cs (First Program in C#)

namespace ConsoleApplicationl

{

class Program

{
static void Main(string[] args)

{




Data Types

® int

e short float f1 =10.31f;

* long decimal d1 =23.34m;
string name = “Your Name” ;

® char

O String int x = 10;

* bool object obj = x; // boxing, implicit
inty = (int) obj; //unboxing, explicit

® float

¢ decimal

® double

® object




C# - Program.cs (First Program in C#)

namespace ConsoleApplicationl

{

class Program

{
static void Main(string[] args)

{
Console.WriteLine(“My First Program in C#”);

Console.ReadKey();
}




Example

static void Main(string[] args)
{
Console.WritelLine("This is my First Program in C#");
int nl, n2;
Console.Write("Enter n1 : ");
nl = Convert.ToInt32(Console.Readline());
Console.Write("Enter n2 : ");
n2 = int.Parse((mn5ﬂle.ReadLine{)}ﬂ
int sum = nl + n2;
Console.WriteLine("The sum is : " + sum);
Console.WriteLine("The sum of " + n1 + " and " + n2 + + sum);
Console.WritelLine("The sum of {@} and {1} is {2}", nl, n2, sum);
Console.ReadKey();

1] n




Operator

* Arithmetic :
o4, - ¥ [ %, ++, --
e Comparison :
0> < >= <= == === |=
* Logical :
> && (AND), || (OR), ! (NOT)
e Assignment :

—_ —_ = *k_ — _
° =, +_1 Iy R /_1 %_

e Conditional or Ternary - ?:




Arithmetic
Operator

Operator Description Example Result
+ Addition X=2 4
y=2
X+Yy
- Subtraction x=5 3
y=2
X-y
* Multiplication x=5 20
y=4
xX*y
/ Division 15/5 3
5/2 2,5
% Modulus (division 5%?2 1
remainder) 10%8 5
10%2 0
++ Increment x=5 xX=6
X++
-- Decrement xX=5 x=4

X__




Assignment

Operator

Operator Example Is The Same As
= X=Yy X=Yy

+ = X+=y X=X+Yy

= X-=Yy X=X-Yy

* = x*=y X=Xx*y

/= X/=y X=X/Yy

% = X% =y X=X%yYy




Comparison
Operator

Operator Description Example
== is equal to 5==8 returns false
=== is equal to (checks for both X=5
value and type)
y=Il5ll
Xx==y returns true
x===Y returns false
= is not equal 5!=8 returns true
> is greater than 5>8 returns false
< is less than 5<8 returns true
>= is greater than or equal to 5>=8 returns false
<= is less than or equal to 5<=8 returns true




Logical
Operator

Operator

Description

Example

&&

and

X=6
y=3

(X < 10 & y > 1) returns true

or

not

I(x==y) returns true




Controlling Program Flow

e Conditions: Making Decisions — 2 Ways
o if ... else statement

o Switch ....case

If condition If condition
is true is false

conditional V

code




Controlling Program Flow

e forms of if..else statement
o if statement
o if...else statement
o if...else if... statement.

e Syntax
o if(expression) {
Statement(s) to be executed if true

}




namespace Consolelppl

{
class CondtionalStmt Example

{
static void Main(string[] args) If - EIse

{
Console.Write("Enter for n: ");
int n = Convert.ToInt32(Console.ReadlLine());
string res = "";
if (n > @)
res = "Greater than 8";
else 1f (n < @)
res = "Less than @";
else

res = "Equals 8";

Console.Writeline(res);
Console.ReadKey();




Controlling Program Flow

* switch ....case expression

Hswitch (expression) {

. ; . case 1
case condition 1: ' code block 1

statement (3) ;

case 2 .
break: S code block 2 @
case condition Z2: case 3 L
-

statement (s) ;
break; )/ /
/ / /
/ /

case condition n:
statement (s) ; smnd " code block N
break;

default: statement (s)




static void Main(string[] args)
{

int n = 1;
switch (n)
{
case 1:
Console.WritelLine("Case 1");
break;
case 2:
Console.WritelLine("Case 2");
break;

default:

Console.WritelLine("Default case");
break;

Example
switch case



Loop

» Used to perform an action repeatedly
till satisfied condition meets.
* 3 Types of Loops
> While loop
> Do While loop
> For loop

* These loops have
° |nitialization statement
> Condition statement
> Update (increment or decrement)
statement

&
while( condition )

{

conditional code ;

}

If condition
is true

code block If condition

is false



Console.Writeline("Starting Loop");
int 1 = 1;

while(i <=1@)

{

Console.Writeline("Count 1is
1++;

}
Console.Writeline("Loop Stopped!™);

do while loop

Console.Writeline("Starting Loop™);
int 1 = 1;

do

{

Console.WritelLine("Count 1is
1++;

} while (i <= 10);
Console.Writeline("Loop Stopped!");

+ 1);

+ 1);

While Loop

Starting Loop
Count 15 :
Count 15 :
Count 15 :
Count 15 :
Count 15 :
Count 15 :
Count 15 :
Count 15 :
Count 15 :
Count 1s - 10

Loop stopped!

Ehm3m4ﬂhhﬂ4hLHIUld



Loop — For loop

e Syntax
for (initialize; condition; iteration) {

Statement(s) to be executed if test condition is true

}
e EX

for (int i=1; i<=10; i++) {
Console.WriteLine(”Countis:” +i);




Array & for each loop

class SecondProgram

{

L rererences

public static void Main(string[] args)
{
Console.WritelLine("Second Program");
int[] arr = { 10, 20, 30 };
for (int i = @; i < arr.Length; i++)
Console.WriteLine("arr[{0}] = {1}", 1, arr[i]);

int sum = 9;
foreach(int j in arr)
{
sum += J;
h
Console.WritelLine("The sum is : " + sum);
Console.ReadKey();




Strings

» Used for storing and manipulating text
» A string variable contains zero or more characters within double quotes.

fJ/f Javascript

// 1234567829

string s = "Javascript”;

Console.WritelLine("Length: + s.length);
Canzcle.writeLine("Indek Of: " + s.IndexOf("va"));
Console.WriteLine("Upper Case: " + s.TolUpper());
Console.Writeline("Lower Case: " + s.ToLower());
Console.WritelLine("Substring: " + s.Substring(e,4));
Console.ReadKey();

(] |




Functions

class FunctionTest

{
static void Main(string[] args)
{
F10) 5
int sq = Square(10);
CDnamle*writeLine(Sq)ﬂ
¥
static void F1()
{
Console.Writeline("This is F1 function™);
¥
static int Square(int n)
{
return n * n;
¥




Function Overloading

static void Main(string[] args)

{
Console.WritelLine("Min : " + Min(5,10));
Console.WritelLine("Min : " + Min("cow", "hen"));
}
static int Min(int nl, int n2)
{
if (nl1 < n2)
return nl;
else
return n2;
}
static string Min(string sl1, string s2)
{

if (sl.CompareTo(s2) < @)
return si;

else
return s2;




Class & Object

* A class consists of data declarations plus functions that act on
the data.

> Normally the data is private

> The public functions (or methods) determine what clients can do with
the data.

* An instance of a class is called an object.
> Objects have identity and lifetime.
o Like variables of built-in types.

37

37



Encapsulation

» By default the class definition encapsulates, or hides, the data
inside it.

o Key concept of object oriented programming.

» The outside world can see and use the data only by calling the
build-in functions.

o Called “methods”

38
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Class Members

e Methods and variables declared inside a class are called
members of that class.

> Member variables are called fields.
> Member functions are called methods.

e In order to be visible outside the class definition, a member
must be declared public.

39
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Objects

e An instance of a class is called an object.

* You can create any number of instances of a given class.
> Each has its own identity and lifetime.
> Each has its own copy of the fields associated with the class.

* When you call a class method, you call it through a particular
object.

> The method sees the data associated with that object.

40
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Creating a Class

class Point

1
public int x, y;
public void Show()
{
Console.Writeline("x : " + x);
Console.WriteLine("y : " + y);
¥
T
class 0O0PClassTest
{

static void Main(string[] args)

{

Point p = new Point();

p.x = 18;
p.y = 20;
p.Show();

Console.ReadKey();



Class - Properties

class Pointl

1

private int x;
private int y;

public int X static void Main(string[] args)

{ {
get { return x; } Pointl p = new Pointl();

} set { x = value; } p.X = 18;

public int Y p.Y = 20

r Console.WritelLine("X : " + p.X);
get { return y; } Console.WriteLine("Y : " + p.Y);
set { y = value; } Console.ReadKey();

¥ ¥

public void Show()

{
Console.WritelLine("x : " + x);
Console.WritelLine("y : " + y);




Class - Constructor

class Point2

{
public int x;
public int yﬂ
public Point2() { } // Default Constructor
public Point2(int x, int y) //Parameterized C.
{
this.x = x;
] class OOPConstructorTest
this.y = y; f
} static void Main(string[] args)
¥ {
Point2 pl = new Point2();
pl.x = 11;
pl.y = 12;

Point2 p2 = new Point2(2,5);




Task

Create a class “Employee” with following specs:

- Field Members : firstName, lastName, salary

- Properties : FirstName, LastName, Salary

- Methods : ShowFullName, IncrementSalary(double s)
- Constructor : Employee( , )

Now, create object of Employee(“Ram”, “Bahadur”, 20000)
Show Employee Fullname & Salary
- Change FirstName to “Hari” & increment salary by 5000

- Show full name & salary




Inheritance

® New Classes called derived classes are created from existing classes
called base classes

public class Class A

{

}
public class Class B : A

{
}




public class ParentClass

{ Inheritance
public ParentClass() { Example
Console WriteLine(“Parent Constructor”);
}
public void Print() {
Console WriteLine(“I’m a Parent Class.”);
}
}

public class ChildClass : ParentClass {

public ChildClass () {
Console WriteLine(“Parent Constructor”);

}




Inheritance Example

class Program

{
static void Main(string[] args)

{
ChildClass cc= new ChildClass();

cc.Print();




Use base key word

public class ParentClass

{
public int x = 10;
public ParentClass()

{

Console WriteLine(“Parent Constructor”);

}
public void Print() {

Console WriteLine(“I’m a Parent Class.”);

}




Use base key word

public class ChildClass : ParentClass

{
public ChildClass() : base()

{
Console WriteLine(“Child Constructor”);
base.Print();
Console WriteLine(base.x);

}



Inheritance Example

class Program

{
static void Main(string[] args)

{
ChildClass cc= new ChildClass()
cc.Print();
Console.ReadKey();




Indexer

* An indexer allows an object to be indexed such as an array.

*» When you define an indexer for a class, this class behaves
similar to a virtual array.

* You can then access the instance of this class using the array
access operator ([ ]).

element-type this[int index]

{
get { //return the value specified by index }

set { //setthe value specified by index }
}



class Student

{ Indexer

private int roll;

public int Roll Example
{
get { return roll; }

set { roll = value; }
'
private int[] marks = new int[3];
public int this[int index]

{

get { return marks[index]; }

set { marks[index] = value; }
¥
public double GetPercent()
{

double total = 8.8;

foreach (int m in marks)

{

total = total + m;

¥

return total / marks.Length;
t




static wvoid Main()

{ Indexer

Student s1 = new Student(); Example
s1.Roll = 1;

s1[@] = 58;

s1[1] = 25;

s1[2] = 38;
Console.Writeline(sl.GetPercent());
Student 52 = new Student();

<2.Roll = 2;
s2[8] = 28;
s2[1] = 38;
$2[2] = 48;

Console.WritelLine(s2.GetPercent());




The sealed class

» Sealed classes are used to restrict the inheritance feature of
object oriented programming. Once a class is defined as a
sealed class, the class cannot be inherited.

* In C#, the sealed modifier is used to define a class as sealed

sealed class SealedClass

{
J




Abstract Class

» Classes can be declared as abstract by using keyword abstract.

» Abstract classes are one of the essential behaviors provided by
NET.

e If you like to make classes that only represent base classes, and
don’t want anyone to create objects of these class types, use
abstract class to implement such functionality.

» Object of this class can be instantiated, but can make
derivations of this.

* The derived class should implement the abstract class members.



Abstract Class

abstract class AbsClass

{
public abstract void AbstractMethod();
public void NonAbstractMethod()
{
Console.WriteLine("NonAbstract Method");
¥
}
class Derived : AbsClass
1
public override void AbstractMethod()
{
Console.WriteLine("Overriding AbstractMethod in Derived Class");
i




Abstract Class

class QO0OPAbstractClass

1

static void Main(string[] args)

{

Derived d = new Derived();

d.NonAbstractMethod();
d.AbstractMethod();

Console.ReadKey();



Interface

» An interface is not a class. It is an entity that is defined by the keyword
Interface.

» By Convention, Interface Name starts with letter ‘I’

* has no implementation; just the declaration of the methods without the
body.

* a class can implement more than one interface but can only inherit from
one class.

e interfaces are used to implement multiple inheritance.
interface IFace

{




Partial Classes

* In C#, a class definition can be divided over multiple files.
> Helpful for large classes with many methods.

> Used by Microsoft in some cases to separate automatically generated
code from user written code.

o |f class defintion is divided over multiple files, each part is
declared as a partial class.

59



Partial Classes

In file circl.cs
partial class Circle

{

// Part of class defintion

In file circ2.cs
partial class Circle

{
// Another part of class definition

60



Exception Handling

* An exception is a problem that arises during the
execution of a program.

» A C# exception is a response to an exceptional
circumstance that arises while a program is running,
such as an attempt to divide by zero, Array Index Out of
Bounds, etc

» Exceptions provide a way to transfer control from one
part of a program to another.

o C# exception handling is built upon four
keywords: try, catch, finally, and throw.

61



Exception Handling

 try: A try block identifies a block of code for which particular
exceptions is activated. It is followed by one or more catch blocks.

e catch: A program catches an exception with an exception handler
at the place in a program where you want to handle the problem.
The catch keyword indicates the catching of an exception.

e finally: The finally block is used to execute a given set of
statements, whether an exception is thrown or not thrown.

* throw: A program throws an exception when a problem shows
up. This is done using a throw keyword.
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Exception
Handling

Syntax

try
{

¥

catch{ ExceptionName

{
¥

catch({ ExceptionName

{
¥

catch( ExceptionName

{

¥
finally

{

// statements causing exception

[/ error handling

// error handling

// error handling

el )
code
e2 )
code
eN )

code

/! statements to be executed

¥

63



Exception Handling

* What will happen to this program?

e In which line, we encounter the error?

* Will this execute all statements?

» Can this program display the last 2 lines?

Int a = 10;
int b =0;
intc=a/ b;

Console.WritelLine(c);
Console.WriteLine(“This is last line”);

A e
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Exception Handling

try
1
int a = 18;
int b = @; // assign b = 2
int ¢ = a / b;
Console.WriteLine(c);
int[] arr = {10, 28, 12};
Console.WriteLine(arr[5]);
¥
catch (DivideByZeroException el)
1
Console.WriteLine(el.ToString());
¥

catch (IndexOutOfRangeException e2)
1

Console.WriteLine("Array index problem");

65



Delegate

o C# delegates are similar to pointers to functions, in C or C++.

» A delegate is a reference type variable that holds the reference
to a method. The reference can be changed at runtime.

» Delegates are especially used for implementing events and the
call-back methods.

» Syntax — Delegate Declaration :
delegate <return-type> <delegate _name> <params>

66



Delegate

* Delegate Declaration :
delegate <return-type> DelegateName> <arg_list>

* Object Creation :

DelegateName d = new DelegateName<function to which the
delegate points>

Invoking :

d<list of args that are to be passed to the functions>

67



Delegate - Ex

[/ 1. Declaration

public delegate void SimpleDelegate();
class DelegateTest

1
static void Main(string[] args)
{
[/ 2. Instantiation
SimpleDelegate d = new SimpleDelegate(MyFunc);
d(); // 3. Invocation
3
public static void MyFunc()
{
Console.Writeline("I was called by delegate");
I

68



Collection Types

» Collection Types are specialized classes for data storage and
retrieval.

» These classes provide support for stacks, queues, lists, and hash
tables.

» Collection classes serve various purposes, such as allocating

memory dynamically to elements and accessing a list of items on
the basis of an index etc.

e Namespaces:
> System.Collection
> System.Collection.Generic

69




Collection Types

» System.Collection
> ArrayList, Hashtable, SortedList, Stack, Queue
» System.Collection.Generic

> generic collection is strongly typed (type safe), that you can
only put one type of object into it.

> This eliminates type mismatches at runtime.
> Another benefit of type safety is that performance is better
o Ex: List, Dictionary

70



Array List — System.Collections

ArraylList al = new Arraylist();
al.Add(1);

al_Add("Hari"):
al.Add(3.4);

Console.Writeline(al.Count);

al.Remove(3.4);
al.RemoveAt(0);
Console.Writeline(al.Count);
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List — System.Collection.Generic

List<string> names = new List<string>();
names .Add("Ram");

names.Add("Hari");

names.Add("Sam");
Console.WritelLine(names.IndexOf("Ram™));

Console.WritelLine(names.Count);
names.RemoveAt(2);

names .Remove("Ram");
foreach(string n in names)

{

Console.WritelLine(n);

72



Unit 2

Introduction to ASP.NET




ASP.NET

e ASP.NET is a web application framework designed and
developed by Microsoft.

e 3 subset of the .NET Framework and successor of the classic
ASP (Active Server Pages).

e \With version 1.0 of the .NET Framework, it was first released in
January 2002.

e before the year 2002 for developing web applications and
services, there was Classic ASP.




NET ASP.NET

WA ER o VE e A el sic = eld e ASP.NET is a main tool that present in the
= [1pal=le Mo e[SV [o] o R ATATe (o) VSRSl o FETa e ISTSTAYEI .NET Framework and aimed at simplifying

based applications. the creation of dynamic webpages.
Server side and client side application You can only develop server side web
development can be done using .NET applications using ASP.NET as it is integrated

framework. with .NET framework.

Mainly used to make business applications It is used to make dynamic web pages and
on the Windows platform. websites using .NET languages.

Its programming can be done using any
language with CIL (Common Intermediate Its programming can be done using any .NET
Language) compiler. compliant language.




.NET Core

.NET Core is a new version of .NET Framework
general-purpose development platform maintained by Microsoft.

It Is a cross-platform framework that runs on Windows, macOS, and Linux
operating systems, used to build different types of applications such as
mobile, desktop, web, cloud, IoT, machine learning, microservices, game, etc.

.NET Core is written from scratch to make it modular, lightweight, fast, and
cross-platform Framework.

It includes the core features that are required to run a basic .NET Core app.
Other features are provided as NuGet packages, which you can add it in your
application as needed. In this way, the .NET Core application speed up the
performance, reduce the memory footprint and becomes easy to maintain.



.NET Core Characteristics

 Open-source Framework: .NET Core Is an open-source framework
maintained by Microsoft and available on GitHub under MIT and Apache 2
licenses. Itis a .NET Foundation project.

o Cross-platform: .NET Core runs on Windows, macOS, and Linux
operating systems. There are different runtime for each operating system
that executes the code and generates the same output.

e Consistent across Architectures: Execute the code with the same
behavior in different instruction set architectures, including x64, x86, and
ARM.

« Wide-range of Applications: Various types of applications can be
developed and run on .NET Core platform such as mobile, desktop, web,
cloud, 10T, machine learning, microservices, game, etc.




Supports Multiple Languages: You can use C#, F#, and Visual Basic
programming languages to develop .NET Core applications. You can use your
favorite IDE, including Visual Studio 2017/2019, Visual Studio Code, Sublime Text,
Vim, etc.

Modular Architecture: supports modular architecture approach using NuGet
packages for various features that can be added to the .NET Core project as
needed. Even the .NET Core library is provided as a NuGet package. The NuGet
package for the default .NET Core application model is Microsoft. NETCore.App. It
reduces the memory footprint, speeds up the performance, and easy to maintain.

CLI Tools: .NET Core includes CLI tools (Command-line interface) for
development and continuous-integration.

Flexible Deployment: .NET Core application can be deployed user-wide or
system-wide or with Docker Containers.

Compatibility: Compatible with .NET Framework and Mono APIs by using .NET
Standard specification



.NET Core Version History

=+

NET 5 Preview 1 VS 2019 16th March, 2020
NET Core 3.x - latest 3.1.3 VS 2019 24th March, 2020 12th March, 2022
NET Core 2.x 2117 VS 2017, 2019 24th March, 2020 21st August, 2021

NET Core 1.x 1.1.13 VS 2017 14th May, 2019  27th May, 2019




.NET Core Framework parts

CLI Tools: A set of tooling for

.NET Core

development and deployment.
Roslyn: Language compiler

CLI Tools

for C# and Visual Basic
CoreFX: Set of framework

Roslyn

libraries.
CoreCLR: A JIT based CLR

CoreFX

(Command Language
Runtime).

CoreCLR




Mono

* Mono is an example of a cross-platform framework available on
Windows, macOS, Linux, and more. It was first designed as an open
source implementation of the .NET Framework on Linux.

* Mono (like .NET) is tied heavily around the C# programming
language, known for its high level of portability.

e For example, the Unity game engine uses C# as a cross-platform way
of creating video games. This is in part due to the language's design.
C# can be turned into CIL (Common Intermediate Language), which
can either be compiled to native code (faster, less portable), or run
through a virtual machine (slower, more portable).

* Mono provides the means to compile, and run C# programs, similar
to the .NET Framework.




ASP.NET Web Forms

o a part of the ASP.NET web application framework and is included
with Visual Studio.

* you can use to create ASP.NET web applications, the others are
ASP.NET MVC, ASP.NET Web Pages, and ASP.NET Single Page
Applications.

» Web Forms are pages that your users request using their browser.
These pages can be written using a combination of HTML, client-
script, server controls, and server code.

» When users request a page, it is compiled and executed on the
server by the framework, and then the framework generates the
HTML markup that the browser can render.
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ASP.NET Web Forms

* An ASP.NET Web Forms page presents information to the user in
any browser or client device.

» The Visual Studio (IDE) lets you drag and drop server controls to
lay out your Web Forms page. You can then easily set properties,
methods, and events for controls on the page or for the page
itself. These properties, methods, and events are used to define
the web page's behavior, look and feel, and so on

» Based on Microsoft ASP.NET technology, in which code that runs
on the server dynamically generates Web page output to the
browser or client device.

11



Features of ASP.NET Web Forms

o Server Controls- ASP.NET Web server controls are similar to familiar HTML
elements, such as buttons and text boxes. Other controls are calendar
controls, and controls that you can use to connect to data sources and
display data.

« Master Pages- ASP.NET master pages allow you to create a consistent
layout for the pages in your application. A single master page defines the
look and feel and standard behavior for all of the pages (or a group of
pages) in your application. You can then create individual content pages
along with the master page to render the web page.

 Working with Data- ASP.NET provides many options for storing, retrieving,
and displaying data in web page Ul elements such as tables and text boxes
and drop-down lists.

12




Features of ASP.NET Web Forms

» Client Script and Client Frameworks - You can write client-script functionality
In ASP.NET Web Form pages to provide responsive user interface to users. You
can also use client script to make asynchronous calls to the Web server while a
page Is running in the browser.

» Routing - URL routing allows you to configure an application to accept request
URL. Arequest URL is simply the URL a user enters into their browser to find a
page on your web site. You use routing to define URLs that are semantically
meaningful to users and that can help with search-engine optimization (SEO).

» State Management - ASP.NET Web Forms includes several options that help
you preserve data on both a per-page basis and an application-wide basis.

o Security - offer features to develop secure application from various
security threats.

13




Features of ASP.NET Web Forms

» Performance - offers performance related to page and server control
processing, state management, data access, application configuration and
loading, and efficient coding practices.

» Internationalization - enables you to create web pages that can obtain content
and other data based on the preferred language setting or localized resource for
the browser or based on the user's explicit choice of language. Content and
other data Is referred to as resources and such data can be stored in resource
files or other sources.

« Debugging and Error Handling - diagnose problems that might arise In
application. Debugging and error handling are well so that applications compile
and run effectively.

 Deployment and Hosting- Visual Studio, ASP.NET, Azure, and IIS provide
tools that help you with the process of deploying and hosting your application

14




Let’s create first ASP.NET Web Forms Project
in Visual Studio 2017/2019
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ASP.NET MVC

* ASP.NET MVC is an open source web development framework
from Microsoft that provides a Model View Controller
architecture.

e ASP.net MVC offers an alternative to ASP.net web forms for
building web applications.

* |t is a part of the .Net platform for building, deploying and
running web apps.

* You can develop web apps and website with the help of HTML,
CSS, jQuery, Javascript, etc.

16



ASP.NET MVC Architecture

e MVC stands for Model, View, and Controller. MVC separates an
application into three components - Model, View, and Controller.

» Model: represents the shape of the data. A class in C# is used to
describe a model. Model objects store data retrieved from the
database. Model represents the data.

* View: View in MVC is a user interface. View display model data to the
user and also enables them to modify them. View in ASP.NET MVC is
HTML, CSS, and some special syntax (Razor syntax) that makes it easy
to communicate with the model and the controller.

e Controller: handles the user request. Typically, the user uses the view
and raises an HTTP request. Controller processes request and returns
the appropriate view as a response. Controller is the request handler.

17




ASP.NET MVC Architecture

View

Controller —
Manipulate

Model
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Request Flow in MVC Architecture

The following figure illustrates the flow of the user's request in

ASP.NET MVC.

http://mydomain.com/home,/about

Enters LIRL

.
o

Browser

Request
—

Response

Madel — & View

Controller
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Let’s create first ASP.NET MVC Project
in Visual Studio 2017/2019
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ASP.NET Web API

e ASP.NET Web API is a framework for building HTTP services that
can be accessed from any client including browsers and mobile
devices.

o It is an ideal platform for building RESTful applications on the .NET
~ramework.

e It works more or less the same way as ASP.NET MVC web
application except that it sends data as a response instead of html
view.

» like a webservice or WCF service but the exception is that it only
supports HTTP protocol.
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ASP.NET Web API
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ASP.NET Web API Characteristics

» a framework for building HTTP services that can be accessed from
any client including browsers and mobile devices.

» Ideal for building RESTful applications on the .NET Framework.

e The ASP.NET Web API iIs an extensible framework for building
HTTP based services that can be accessed in different applications
on different platforms such as web, windows, mobile etc.

o It works more or less the same way as ASP.NET MVC web

application except that it sends data as a response instead of html
view.

» like a webservice or WCF service but the exception is that it only
supports HTTP protocol.
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ASP.NET Web API Project

You can create a Web API project in two ways.
o Web API with MVC Project
» Stand-alone Web API Project

24



ASP.NET Core

» new version of the ASP.NET web framework
» free, open-source, and cross-platform framework

« ASP.NET Core applications can run on Windows, Linux, and Mac.
So you don't need to build different apps for different platforms using
different frameworks.

» allows you to use and manage modern Ul frameworks such as
AngularJS, ReactJS, Umber, Bootstrap, etc. using Bower (a
package manager for the web).

25



.NET Core Vs ASP.NET Core

.NET Core ASP.NET Core
0 )= e o <RE T s o (e 1100 Eld (o] 7 1y I Open-source and Cross-platform

N\ T RN i ER GRS S ASP.NET Core is a web framework to build
applications build on it. web apps, loT apps, and mobile backends on
the top of .NET Core or .NET Framework.
LEEHRN R ER TGy RGN B There is no separate runtime and SDK are

=l e ER AL EL R et -8 available for ASP.NET Core. .NET Core runtime
SDK to build applications. and SDK includes ASP.NET Core libraries.

.NET Core 3.1 - latest version ASP.NET Core 3.1

There is no separate versioning for ASP.NET

Core. It is the same as .NET Core versions.
26




ASP.NET Core

o Supports Multiple Platforms

 Hosting: ASP.NET Core web application can be hosted on multiple platforms
with any web server such as IIS, Apache etc. It is not dependent only on |IS as
a standard .NET Framework.

« Fast - This reduces the request pipeline and improves performance and
scalability.

e |oC Container: It includes the built-in loC container for automatic dependency
Injection which makes it maintainable and testable.

e Integration with Modern Ul Frameworks

« Code Sharing: allow to build a class library that can be used with other .NET
frameworks such as .NET Framework 4.x or Mono. Thus a single code base

can be shared across frameworks.
27




ASP.NET Core

« Side-by-Side App Versioning: ASP.NET Core runs on .NET Core, which
supports the simultaneous running of multiple versions of applications.

- Smaller Deployment Footprint: ASP.NET Core application runs on .NET Core,
which is smaller than the full .NET Framework. So, the application which uses
only a part of .NET CoreFX will have a smaller deployment size. This reduces
the deployment footprint.
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Compilation and Execution of .NET applications:
CLI, MSIL and CLR

C# programs run on the .NET Framework, which includes the common
language runtime (CLR) and a unified set of class libraries. The CLR is the
commercial implementation by Microsoft of the common language infrastructure
(CLI), an international standard that is the basis for creating execution and
development environments in which languages and libraries work together
seamlessly.

Source code written in C# is compiled into an Microsoft Intermediate Language
(MSIL) or simply(IS) that conforms to the CLI specification. The IL code are
stored on disk in an executable file called an assembly, typically with an
extension of .exe or .dll.

CLR performs just in time (JIT) compilation to convert the IL code to native
machine instructions. The CLR also provides other services related to

automatic garbage collection, exception handling, and resource management.
29



Compilation and Execution of .NET applications:
CLI, MSIL and CLR

Code that is executed by the CLR is sometimes referred to as "managed
code," Iin contrast to "unmanaged code" which is compiled into native
machine language that targets a specific system.

Language interoperability is a key feature of the .NET Framework.
Because the IL code produced by the C# compiler conforms to the
Common Type Specification (CTS), IL code generated from C# can
Interact with code that was generated from the .NET versions of Visual
Basic, Visual C++, or any of more than 20 other CTS-compliant
languages. A single assembly may contain multiple modules written in
different .NET languages, and the types can reference each other just as
If they were written in the same language.
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NET CLI: build, run, test and deploy .NET Core Applications

The .NET Core command-line interface (CLI) is a new cross-platform tool
for creating, restoring packages, building, running and publishing .NET
applications.

Visual Studio internally uses this CLI to restore, build and publish an
application. Other higher level IDEs, editors and tools can use CLI to
support .NET Core applications.

The .NET Core CLI Is installed with .NET Core SDK for selected
platforms. So we don't need to install it separately on the development
machine. We can verify whether the CLI is installed properly by opening
command prompt in Windows and writing dotnet and pressing Enter. If it
displays usage and help as shown below then it means it is installed

properly.
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NET CLI: build, run, test and deploy .NET Core Applications

C\Windows'system32\cmd.exe

Microsoft Windows [Uersion 6.1.76H11
Copyright <(c? 2008? Microsoft Corporation. All rights reserved.

C:sUszserssdell>dotnet

Usage: dotnet [options]
Uzage: dotnet [path—to—-applicationl

Options:

—hi—help Dizsplay help.
——yeprsion Dizplay version.

path—to—application:
The path to an application .dll file to execute.

C:sUserssdell >




Creating and running the Hello World console application

» Execute the following commands on the command line or terminal:

o

o

mkdir hwapp
cd hwapp
dotnet new console
The command dotnet new console creates a new Hello World
console application in the current folder.
The dotnet new console command creates two files:
Program.cs and
hwapp.csproj
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Program.cs should look similar to the following listing

using System;
namespace hwapp

{

public class Program

{

public static void Main(string[] args)

{
Console.WritelLine("Hello World");
}
}
}
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Running the Hello World console application

 When you're using the .NET Core SDK, your application will be built
automatically when needed. There’s no need to worry about
whether or not you're executing the latest code.

* Try running the Hello World application by executing dotnet run at
the command line or terminal.

BN Administrator: CAWINDOWS\system32\cmd.exe

D:\hwapp>dotnet run
Hello World!

D:\hwapp>
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Unit 3

HTTP & ASP.NET Core




The relationship between ASP.NET Core, ASP.NET, .NET Core, and .NET Framework.
ASP.NET Core runs on both .NET Framework and .NET Core, so it can run cross-platform.

Web framework

.NET platform

Operating system

T Y

ASPNET Core runs on
both .NET Core and
.NET Framework.

ASP.NET 4.5 runs on
.NET Framework only.

ASP.NET/
SR E ASP.NET MVC
.NET Core .NET Framework
Windows
Linux Windows
macOS

.NET Core runs on
multiple platforms.

.NET Framework runs
on Windows only.



ASP.NET Core application model

You write a .NET Core console
app that starts up an instance
of an ASPNET Core web server.

Microsoft provides, by default,
a cross-platform web server
called Kestrel.

Your web application logic is run by
Kestrel. You'll use various libraries
to enable features such as logging
and HTML generation as required.

ASP.NET Core console application

ASP.NET Core Kestrel
web server

:

Y
Web application logic
Logging Static files
Configuration HTMI.‘
generation




1. User requests a web page by a URL. 5. Browser renders HTML on page.

H OW d O e S hitp://thewebsite.com/the/page.html http://thewebsite.com/the/page.html
Welcome to the web page!
L]
an HTTP . %o
2. Browser sends HTTP
request to server.

request e
work?

4. Server sends HTML in HTTP
response back to browser.

AN

HTTP response

<HTML>
<HEAD></HEAD 3. Server interprets request and

<BODY></BODY> | generates appropriate HTML.
< /HTML=>




How does an HTTP web request work

» the user starts by requesting a web page, which causes an HTTP
request to be sent to the server. The server interprets the request,
generates the necessary HTML, and sends it back in an HTTP
response. The browser can then display the web page.

* Once the server receives the request, it will check that it makes
sense, and if it does, will generate an HTTP response. Depending on

the request,

JavaScript fi
e Assoon ast

this response could be a web page, an image, a
e, or a simple acknowledgment.

ne user’s browser begins receiving the HTTP response, it

can start dis

olaying content on the screen, but the HTML page may

also reference other pages and links on the server.



How does
ASP.NET
Core
process

a request?

T =
Request - :;I-v} Response
NNy
1. HTTP request is made to the 7. HTTP response
server and is received by the is sent to browser.

reverse proxy.

Reverse proxy
(IS/NGINX/Apache)

A
2. Request is forwarded by IIS/ 6. Web server forwards
NGINX/Apache to ASP.NETCore. response to reverse proxy.
s T EOP
L
ASP.NET Core web server
(Kestrel)

3. ASPNET Core web
server receives the I:”TF middleware back to web server.
request and passes it to

the middleware.

ASP.NET Core infrastructure
and application logic

|
|
|
|
|
|
|
I
|
l x : 5. Response passes through

|
|
|
|
|
|
|
|
:
|
ASP.NET Core application
|

4. Request is processed by the application,
which generates a response.



How does ASP.NET Core process a request?

* A request is received from a browser at the reverse proxy, which passes
the request to the ASP.NET Core application, which runs a self-hosted
web server.

» The web server processes the request and passes it to the body of the
application, which generates a response and returns it to the web server.
The web server relays this to the reverse proxy, which sends the response
to the browser.

» benefit of a reverse proxy is that it can be hardened against potential
threats from the public internet. They’re often responsible for additional
aspects, such as restarting a process that has crashed. Kestrel can stay as
a simple HTTP server. Think of it as a simple separation of concerns:
Kestrel is concerned with generating HTTP responses; a reverse proxy is

concerned with handling the connection to the internet. 7




Common web application architectures

* monolithic application

 All-in-one applications

» Layered Architecture

» Traditional "N-Layer" architecture applications
e Clean architecture




Monolithic Application

A monolithic application is one that is entirely self-contained, In
terms of its behavior.

» It may Interact with other services or data stores In the course of
performing its operations, but the core of its behavior runs within its
own process and the entire application is typically deployed as a
single unit.

 If such an application needs to scale horizontally, typically the entire
application is duplicated across multiple servers or virtual machines.




All-in-one applications

e The smallest possible number of projects for an application
architecture is one. In this architecture, the entire logic of the
application is contained in a single project, compiled to a single
assembly, and deployed as a single unit.

A new ASP.NET Core project, whether created in Visual Studio or from
the command line, starts out as a simple "all-in-one" monolith. It
contains all of the behavior of the application, including presentation,
business, and data access logic. In a single project scenario, separation
of concerns is achieved through the use of folders. The default
template includes separate folders for MVC pattern responsibilities of
Models, Views, and Controllers, as well as additional folders for Data
and Services. Figure shows the file structure of a single-project app.
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VS Solution Structure

Solution Explorer * 0 x
QE- o-58E K=
Search Solution Explorer (Cirl+:) P-

B Solution 'MonclithSample' (1 project)

4 [z] MonolithSample

&3 Connected Services

P =B Dependencies
b & Properties
b @ wwwroot
r Controllers 0
4 & Data | Data Access Logic
b 1 Migrations < - EF Migrations
b c* ApplicationDbContest.cs | - EF DbContext and model design
i Models
2] AccountViewModels < Ul MDdElE

[ ManageViewhodels

B c* ApplicationUser.cs
Fi Services

B C* |EmailSender.cs -

e ———— ‘ Application Services (interfaces and implementations)

c* MessageServices.cs
F Views
Account
Home
Manage » = =
Shored - Presentation Logic
_Viewlmports.cshtm|
[A _ViewStart.cshtml
1|r'-_"'| app.config
b LT appsettings.json
b ST bowerjson i . i i
£T bundieconfigjson E Application Entry Point and Configuration
P Program.cs
P o= Startup.cs

Vv v v
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* Presentation details should be limited as much as possible to the Views
folder, and data access implementation details should be limited to classes
kept in the Data folder. Business logic should reside in services and classes
within the Models folder.

o Although simple, the single-project monolithic solution has some
disadvantages:

> As the project's size and complexity grows, the number of files and
folders will continue to grow as well. User interface (Ul) reside in multiple
folders, which aren't grouped together alphabetically.

> Business logic is scattered between the Models and Services folders, anc
there's no clear indication of which classes in which folders shoulc
depend on which others. This lack of organization at the project leve
frequently leads to spaghetti code.

c To address these issues, applications often evolve into multi-project
solutions, where each project is considered to reside in a particular layer
of the application.

12



Layered Architechture

» As applications grow in complexity, one way to manage that
complexity is to break up the application according to its
responsibilities or concerns. This follows the separation of concerns
principle and can help keep a growing codebase organized so that
developers can easily find where certain functionality is implemented.

» Layered architecture offers a number of advantages beyond just code
organization, though. By organizing code into layers, common low-
level functionality can be reused throughout the application.

» With a layered architecture, applications can enforce restrictions on

whic
enca

osulation. When a

that work with it shoulc

onw

a single change doesn't impact the entire application.

nich other layers, t

n layers can communicate with other layers. This helps to achieve

ayer is changed or replaced, only those layers
be impacted. By limiting which layers depend

ne impact of changes can be mitigated so that
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Traditional "N-Layer" architecture applications

Application Layers

User Interface

| |
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Traditional "N-Layer" architecture applications

These layers are frequently abbreviated as Ul, BLL (Business Logic
Layer), and DAL (Data Access Layer). Using this architecture, users

make requests through the Ul layer, which interacts only wit
The BLL, in turn, can call the DAL for data access requests. T

n the BLL.
ne Ul layer

shouldn't make any requests to the DAL directly, nor shoulo

It Interact

with persistence directly through other means. Likewise, the BLL should

only interact with persistence by going through the DAL.

One disadvantage of this traditional layering approach is that compile-
time dependencies run from the top to the bottom. That is, the Ul layer
depends on the BLL, which depends on the DAL. This means that the
BLL, which usually holds the most important logic in the application, is
dependent on data access implementation details (and often on the

existence of a database). Testing business logic in such an arc

hitecture Is

often difficult, requiring a test database. The dependency inversion

principle can be used to address this issue.
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VS Solution Structure

Solution Explorer v 1 x
WmE- ©-5 g )"|:|
Figure shows
’ b -’:ﬁtzplzatznhre “ Business/Application Model an _ example
: - Eﬂ‘::f:ﬁ:::i“ ) | D_aEtFa hﬂc;‘:ﬁjﬁ:—ﬂgi{ (Infrastructure) EO | ULIO n, o
b o ColonComotooedc | EF Dbtontext and model design al;epal‘lclgtglo ) int(e)
4 /F] Web
e three projects

b & Properties
b s wwwroot by

P a Controllers

> a1 Pics responsibility
P &NN Services
b &1 ViewModels = « Presentation Logic (or Iayer).

b a0 Views
b af] appsettings.json
b af] bower.json
&&] bundleconfigjson
b &c* CatalogSettings.cs
P &C* Program.cs
P &cC* Startup.cs _

tests < Automated Tests




Clean architecture

Applications that follow the Dependency Inversion Principle as well as the
Domain-Driven Design (DDD) principles tend to arrive at a similar
architecture. It's been cited as the Onion Architecture or Clean
Architecture.

Clean architecture puts the business logic and application model at the
center of the application. Instead of having business logic depend on data
access or other infrastructure concerns, this dependency is inverted:
Infrastructure and implementation details depend on the Application Core.

This is achieved by defining abstractions, or interfaces, in the Application
Core, which are then implemented by types defined in the Infrastructure
layer. A common way of visualizing this architecture is to use a series of
concentric circles, similar to an onion.
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Clean Architecture Layers (Onion view)

User Interface

Controllers View Models

Domain Services

Interfaces

Entities

Application Core External Dependencies

S &

N
;‘
el

Figure: style of architectural representation.
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Clean Architecture

» |In the diagram, dependencies flow toward the innermost circle. The Application
Core takes its name from its position at the core of this diagram. And you can
see on the diagram that the Application Core has no dependencies on other
application layers.

» The application's entities and interfaces are at the very center.

o Just outside, but still in the Application Core, are domain services, which
typically implement interfaces defined in the inner circle.

o Outside of the Application Core, both the Ul and the Infrastructure layers
depend on the Application Core, but not on one another (necessatrily).
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== mmmmmm = Optional Compile-Time Dependency

Clean Architecture Layers o

User Interface

I
I
I
¥

Application Core

Figure shows a more traditional horizontal layer diagram that better reflects the
dependency between the Ul and other layers.
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ASP.NET Core Architecture Overview

The ideology behind ASP.NET Core in general, as the name suggests, is
to lay out web logic, infrastructure, and core components from each other
In order to provide a more development-friendly environment.

The concept iIs somewhat similar to "N" tier/layer architecture, the only
difference i1s that ASP.NET Core defines the layers as the core
component of the platform which relieves the developer from redefining it
In order to make a solution more modular and reusable.

What happens in ASP.NET Core is that the main business logic and Ul
logic are encapsulated in ASP.NET Core Web App layer, while the
database access layer, cache services, and web APl services are
encapsulated In Infrastructure layer and common utilities, objects,
Interfaces and reusable business services are encapsulated as micro-
services in application core layer.
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ASP.NET Core Architecture Overview

« ASP.NET Core creates necessary pre-defined "N" tier/layers
architecture for us developers automatically, which saves our time
and effort to worry less about the complexity of necessary "N"
tier/architecture of the web project and focus more on the business
logic.

« ASP.NET Core that brings the benefit of a pre-built architectural
framework that eases out tier deployment of the project along with
oroviding pre-build Single Page Application (SPA) design pattern,
Razor Pages (Page based more cleaner MVC model) design
pattern, and traditional MVC (View based model) design pattern.

 These design patterns are mostly used in a hybrid manner but can
be utilized as an individual-only pattern as well.
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MVC(Model — View - Controller) Design Pattern

« The MVC design has actually been around for a few decades, and
It's been used across many different technologies.

« The MVC design pattern is a popular design pattern for the user
Interface layer of a software application.

e In larger applications, you typically combine a model-view-controller
Ul layer with other design patterns in the application, like data
access patterns and messaging patterns.

» These will all go together to build the full application stack.
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MVC(Model — View - Controller) Design Pattern

« The MVC separates the user interface (Ul) of an application into the
following three parts -

e The Model - A set of classes that describes the data you are
working with as well as the business logic.

« The View — Defines how the application’s Ul will be displayed. It is a
pure HTML which decides how the Ul is going to look like.

e The Controller — A set of classes that handles communication from
the user, overall application flow, and application-specific logic.

25



ldea Behind MVC

The idea iIs that you'll have a component called the view which is solely
responsible for rendering this user interface whether it should be HTML or
whether it actually should be a Ul widget on a desktop application.

The view talks to a model, and that model contains all the data that the
view needs to display.

In a web application, the view might not have any code associated with it
at all.

It might just have HTML and then some expressions of where to take the
pieces of data from the model and plug them into the correct places
Inside the HTML template that you've built in the view.

The controller organizes everything. When an HTTP request arrives for
an MVC application, the request gets routed to a controller, and then it's
up to the controller to talk to either the database, the file system, or a
model.
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ldea Behind MVC
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Projects and Conventions

Solution Explorer

RE- -5 dE F
Search Solution Explorer (Ctrl+;)

ba] Solution 'MyFirstCoredpp' (1 project)
4 MyFirstCoreApp

{§ Connected Services

[ @ Dependencies
 Properties
@ wwwroot

R

R

* Program.cs
C# Startup.cs

=

Solution Explorer - Folder View * 0 X
Search Selution Explorer - Felder View (Ctrl+;) P -

4 MyFirstCorefpp (D:\MyFirstCoreApp)
4 MyFirstCorefpp

bin

obj

Properties

W ==

wwwroot
MyFirstCorelpp.csproj
* Program.cs
¢ Startup.cs
ba] MyFirstCoreApp.sin
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Projects and Conventions

e .CSproj-

Visual Studio now uses
.csproj file to manage
projects.

We can edit the .csproj

settings by :

 right click on the
project

» Select Edit < project-
name>.csproj as
shown below.

&

Build
Rebuild
Clean
View
Pack
Publish...

Configure Application Insights...

Owverview

Scope to This
Mew Solution Explorer View
Edit MyFirstCorefpp.csproj

Add
Manage MuGet Packages...
Manage Bower Packages...

Manage User Secrets

Set as StartUp Project

Solution Explorer

@WE-|o-5dB|F
th Solution Explorer (Ctrl+;)

Solution '‘MyFirstCorefpp’ (1 project]
1| MyFirstCoreApp
Zf: Connected Services
b @ Dependencies
b Properties
@ wwwroot
B Mew Text Document.bd
p C* Program.cs
b Startup.cs




Projects and Conventions

1 EkPPGject Sdk="Microsoft.NET.Sdk.Web" >

2

3 = <PropertyGroup>

Ll {TargetFramework>netcoreapp2.l1</TargetFramework>

5 < /PropertyGroup>

(3

7 = «LItemGroup:

a8 {Folder Include="wwwroot\" />

9 {/ItemGroup>
18
11 = <«ItemGroup>
12 {PackageReference Include="Microsoft.AspNetCore.App" />
13 {PackageReference Include="Microsoft.AspNetCore.Razor.Design" Version="2.1.2" PrivatelAssets="All" />
14 < /ItemGroup>
15
16 {/Project>
17

» The .csproj for the project looks like above.

» The csproj file includes settings related to targeted .NET Frameworks, project

folders, NuGet package references etc. o




Projects and Conventions

» Dependencies

The Dependencies in the
ASP.NET Core project
contain all the Installed
server-side NuGet packages,
as shown.

Solution Explorer * 1 X

o @ e M-

Search Solution Explorer (Ctrl+;) 2~
bl Solution 'MyFirstCorelpp' (1 project)

4 [=1) MyFirstCoreApp

F |

[
[

¢ Connected Services
-a Dependencies
b g Analyzers
4 g MuGet
b g Microsoft. AspMetCore.App (2.1.1)

B Microsoft. AspMetCore.Razor.Design (2.1.2)
4 3 SDK
b3 Microsoft. AspMetCore.App (2.1.1)
b3 Microsoft. NETCoreApp (21)

Froperties

L xl
g wwwroot

# Program.cs
c# Startup.cs
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» Right click on "Dependencies" and then click "Manage NuGet Packages.." to see
the installed NuGet packages, as shown below.

e It has installed three packages, Microsoft.AspNetCore.App package is for
ASP.NET web application, Microsoft. AspNetCore.Razor.Design package is for Razor
engine, and Microsoft. NETCore.App package is for .NET Core API.

: 5. p-aB [y pf=
Browse  Installed  Updatesfl NuGet Package Manager: MyFirstCoreApp m =19 __E—'_" 2 [ A

P~ G : Include prerelease Package source: nuget.org - 03 m Solution "MyFirstCorefpp' (1 project)
4 [=1) MyFirstCoreApp

&% Connected Senvices

4 2§ Dependencies
I Microsoft.AspNetCore.App by Microsoft, 14.8 © v211 ¥ b F Aahaen

Microsoft.AspNetCore.App 4 P NuGet

T b @ MicrosoftAspNetCore App (21.1)
B Microsoft. AspNetCore.Razor.Design (2.1.2)

f3d Microsoft.AspNetCore Razor.Design by Mic © v212% 4 3 soK
Razoris a mariFup syntax for ad !:Iing 5er1.'gr—5i:|e logic to v2.2D . b BE& Microsoft.AspNetCoreApp (211)
web pages. This package contains M5Build support fo... - b 32 Microsoft.NETCoreApp (2)
b M Properties
IM3d Microsoft. NETCore.App by Microsoft, 107M do © v21.00F 6 wwwroot
A set of NET APT's that are included in the default MET b € Program.cs
Core application model. b C* Startup.cs




Properties : The Properties node includes launchSettings.json file which includes Visual
Studio profiles of debug settings. The following is a default launchSettings.json file.

L

0|dx3 133

FERE

IqII:II:IJ_

launchSettings.json +® X

Schema: http://)son.schemastore.org/launchsettings

WMo ld R

W20 osd

S

"iisSettings": {
"windowsAuthentication™: false,
"anonymousAuthentication™: true,
"iisExpress": {
“applicationUrl™: “"http://localhost:58944/",
"ss1Port™: @
h
Fa
"profiles”: {
"IIS Express": {
"commandName": “"IISExpress”,
"launchBrowser”: true,
"envirenmentVariables": {
"ASPNETCORE_ENVIRONMENT": "Development”
b
}1

108

MyFirstCorefpp": {

"commandName": "Project”,

"launchBrowser”: true,

“environmentVariables": {
"ASPNETCORE_ENVIRONMENT": "Development”

I

"applicationUrl™: “"http://localhost:58945/"

|

Solution Explorer
QE-o-5 @ K
Search Solution Explorer (Cirl+;}

LG I

fa] Solution 'MyFirstCaredpp' (1 project)
4 [ MyFirstCoreApp
Z§ Connected Services

«n Dependencies
M Properties

,-L-E launch5ettings.json
B wwwroot

B ©* Program.cs
* Startup.cs




Unit4

Creating ASP.NET Core MVC Applications




Creating a Web App & Run

* From the Visual Studio, select Create a new project.

» Select ASP.NET Core Web Application and then select Next.
» Name the project as you like or WebApplicationCoreST
» Choose the location path to save your project.

e Click Create

o Select Web Application(Model-View-Controller), and then select
Create.

* Now, To run the App,
> Select Ctrl-F5 to run the app in non-debug mode, Or

> Select IIS Express Button.




Setting up the Environment

ASP.NET Core wwroot Folder

» By default, the wwwroot folder in the ASP.NET Core project is treated as a
web root folder. Static files can be stored in any folder under the web root
and accessed with a relative path to that root.

* In ASP.NET Core, only those files that are in the web root - wwwroot folder
can be served over an http request. All other files are blocked and cannot
be served by default.

* Generally, we find static files such as JavaScript, CSS, Images, library scripts
etc. in the wwwroot folder

* You can access static files with base URL and file name. For example, for css

folder, we can access via http://localhost:<port>/css/app.css
3




Setting up the Environment

ASP.NET Core — Program.cs Class

» ASP.NET Core web application project starts executing from the
entry point - public static void Main() in Program class.
ASP.NET Core — Startup.cs Class

o |t is like Global.asax in the traditional .NET application. As the
name suggests, it is executed first when the application starts.

» The startup class can be configured at the time of configuring the
host in the Main() method of Program class.



Add a controller

 |In Solution Explorer, right-click Controllers > Add > Controller
* In the Add Scaffold dialog box, select Controller Class — Empty

e In the Add Empty MVC Controller dialog, enter HelloWorldController and
select Add.

» Replace the contents of Controllers/HelloWorldController.cs
public string Index() {
return "This is my default action...";
}
public string Welcome() {
return "This is the Welcome action method...";




Add a controller

* MVC invokes controller classes (and the action methods within them)
depending on the incoming URL.
* The default URL routing logic used by MVC uses a format like this:
/[Controller]/[ActionName]/[Parameters]
* The routing format is set in the Configure method in Startup.cs file.
app.UseEndpoints(endpoints =>
{
endpoints.MapControllerRoute(
name: "default",
pattern: "{controller=Home}/{action=Index}/{id?}");

1;




e Run your app & Check with these url in your browser
o https://localhost:{PORT}/HelloWorld
o https://localhost:{PORT}/HelloWorld/Index
o https://localhost:{PORT}/HelloWorld/Welcome
» Make changes for Welcome Method like this:
// GET: /HelloWorld/Welcome/
// Requires using System.Text.Encodings.Web;

public string Welcome(string name, int numTimes = 1)

{

return HtmlEncoder.Default.Encode(S"Hello {name}, NumTimes is: {numTimes}");

}

* Check on your browser with these:
o https://localhost:{PORT}/HelloWorld/Welcome?name=AAA&numtimes=4




» Make changes again for Welcome Method with following code

public string Welcome(string name, int ID = 1) {
return HtmlEncoder.Default.Encode(S"Hello {name}, ID is: {ID}");

}
o Check on your browser with these:

> http://localhost:{PORT}/HelloWorld/Welcome/3?name=AAA

* Here, the third URL segment matched the route parameter id. The
Welcome method contains a parameter id that matched the URL template
in the MapControllerRoute method in Startup.cs file. The trailing ? (in id?)
indicates the id parameter is optional.

app.UseEndpoints(endpoints =>
{

endpoints.MapControllerRoute(

name: "default",
pattern: "{controller=Home}/{action=Index}/{id?}");

}); .




Add a view

- In your Project, Right click on the Views folder, and then Add > New
Folder and name the folder HelloWorld.

- Right click on the Views/HelloWorld folder, and then Add > New Item.
* In the Add New Item dialog

* |In the search box in the upper-right, enter view

Select Razor View -

Keep the Name box value, Index.cshtml.
Select Add 1

- Replace the contents of the
Views/HelloWorld/Index.cshtml
Razor view file with the following

ViewData["Title"] = "Index";

ch2>Index</h2>»

<p*Hello from our View Templatel</p>»



Your Controller and View

public class HelloWorldController : Controller

{
pu_h_li:: "Lﬂu:timﬂResult Index() Index.cshtml
{
return View(); a1
¥ ViewData["Title"] = "Index";
h
<h2>Index</h2>

<p>*Hello from our View Template!</p»

* Navigate to https://localhost:{PORT}/HelloWorld

10



Change views and layout pages

- In page, Select the menu links (WebApplicationCoreS1, Home, Privacy)

- Each page shows the same menu layout.
- The menu layout is implemented in the Views/Shared/ Layout.cshtml file.

- Open the Views/Shared/ Layout.cshtml file.

- Layout templates allow you to specify the HTML container layout of your
site in one place and then apply it across multiple pages in your site.

- Find the @RenderBody() line. RenderBody is a placeholder where all the
view-specific pages you create show up, wrapped in the layout page.

- For example, if you select the Privacy link, the Views/Home/Privacy.cshtml
view is rendered inside the RenderBody method.

11




Change the title, footer, and menu link in the layout file

- Replace the content of the Views/Shared/ Layout.cshtml file with the
following markup. The changes are highlighted:

<ITDOCITYPE html>
<html lang="en">

<head>
<meta charset="utf-8" />
<meta name="viewport" content="width=device-width, initial-scale=1.8" />

<title>pViewData["Title”] - WebApplicationCoreSl</title>

<div class="container™>»

<a class="navbar-brand"” asp-area="" asp-controller="Home" asp-action="Index">WebApplicationCoreSil</

<footer class="border-top footer text-muted":>

<div class="container":

&copy; 2020 - WebApplicationCoreSl - <a asp-area="" asp-controller="Home" asp-action="Privacy">Privacy<

12



Passing Data from the Controller to the View

- Controllers are responsible for providing the data required in order for a
view template to render a response.

- In HelloWorldController.cs, change the Welcome method to add a Message
and NumTimes value to the ViewData dictionary.

- The ViewData dictionary is a dynamic object, which means any type can be
used; the ViewData object has no defined properties until you put
something inside it. The MVC model binding system automatically maps
the named parameters (name and numTimes) from the query string in the
address bar to parameters in your method.

- Ex looks like :

13



Passing Data from the Controller to the View

public class HelloWorldController : Controller

{

public TActionResult Index()

{
return View();

'

public IActionResult Welcome(string name, int numTimes = 1)

{
ViewData| "Message”] = "Hello " + name;
ViewData[ "MumTimes"] = numTimes;
return View();

'

14



Passing Data from the Controller to the View

o

ViewData["Title"] = "Welcome™;
.
J

<h2>kelcome</h2>»

<ul>
gfor (int 1 = 8; 1 < (int)ViewData["NumTimes"]; i++)
i
<li»@ViewData[ "Message"]</1i>
¥

<fuls»

15



Controllers Responsibities

» Controllers are usually placed in a folder called "Controllers”,
directly in the root of your MVC project.

» They are usually named based on their purpose, with the word
"Controller" as a suffix.

» The Controller has three major responsibilities
> Handle the Request from the User

°c Build a Model — Controller Action method executes the
application logic and builds a model

cSend the Response — it returns the Result in
HTML/File/JSON/XML or other format as requested by user.



Controller Scaffolding Option

Add Scaffold

4 Installed

I+ Common

2D

%)

I s

MVC Controller - Empty

MVC Controller with read /write actions

MVC Controller with views, using Entity Framework

API Controller - Empty

API Controller with read /write actions

API Controller with actions, using Entity Framework

MVC Controller - Empty
by Microsoft
v1.0.0.0

An empty MVC controller.

Id: MvcControllerEmptyScaffolder

Add

Cancel
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Controller Scaffolding Option

e Both the MVC and APl Controller inherits from the same
Controller class and there is not much difference between them,

except that API Controller is expected to return the data in
serialized format to the client.

* Further, we have three options under both types of controllers.
° Empty
> With Read/Write Actions
> With Views, using entity framework

18



Actions

» Controller is just a regular .NET class, it can have fields, properties
and methods.

» Methods of a Controller class is referred to as actions - a method
usually corresponds to an action in your application, which then
returns something to the browser/user.

» All public methods on a Controller class is considered an Action.

» For instance, the browser might request a URL like
/Products/Details/1 and then you want your ProductsController
to handle this request with a method/action called Details.

19



When creating Action Method, points to remember

» Action methods Must be a public method

e The Action method cannot be a Static method or an Extension

method.

» The Constructor, getter or setter cannot be used.

e Inherited methods cannot be used as the Action method.

e Action met
e Action Met
e Action met

NOC
NOC

N0C

s cannot contain ref or out parameters.
s cannot contain the attribute [NonAction].
s cannot be overloaded

20



Actions Verbs

*» To gain more control of how your actions are called, you can
decorate them with the so-called Action Verbs.

* an action can be accessed using all possible HTTP methods (the
most common ones are GET and POST)

» Edit action can be accessed with a GET request.
[HttpGet]
public IActionResult Edit()

{

return View();

¥

21



Actions Verbs

[HttpGet]
public IActionResult Edit()

{
return Content("Edit");

¥

[HttpPost]
public IActionResult Edit(Product product)

{
product.Save();

return Content("Product Updated!");
}

22



Actions Result Types

» When the Action (method) finishes it work, it will usually return
something, as |IActionResult interface

* Some list of Action Result are:
> Content() - returns specified string as plain text
> View() - returns a View to the client
o PartialView() - returns a Partial View to the client
° File() - returns the content of a specified file to the client
° Json() - returns a JSON response to the client

o Redirect() and RedirectPermanent() - returns a redirect response to the
browser (temporary or permanent), redirecting the user to another URL

> StatusCode() - returns a custom status code to the client

23



Actions Result - Ex

» A common use case for this is to return either a View or a piece of
content if the requested content is found, or a 404 (Page not

Found) error if its not found. It could look like this:
public IActionResult Details(int id)

{
Product product = GetProduct(id);
if (product != null)
return View(product);

return NotFound();




Rendering HTML with Views

* |n MVC pattern, the view handles the app's data presentation and
user interaction.

e Aview is an HTML template with embedded Razor markup. Razor
markup is code that interacts with HTML markup to produce a
webpage that's sent to the client

e In ASP.NET Core MVC, views are .cshtml files that use the C#
programming language in Razor markup. Usually, view files are
grouped into folders named for each of the app's controllers. The
folders are stored in a Views folder at the root of the app .



Rendering HTML with Views

» The Home controller is represented by a Home folder inside the Views folder.
The Home folder contains the views for the About, Contact, and Index
(homepage) webpages. When a user requests one of these three webpages,
controller actions in the Home controller determine which of the three views
is used to build and return a webpage to the user.

o Use layouts to provide consistent webpage sections and reduce code
repetition. Layouts often contain the header, navigation and menu elements,
and the footer. The header and footer usually contain boilerplate markup for
many metadata elements and links to script and style assets. Layouts help you
avoid this boilerplate markup in your views.

26




Creating a View

» To create a view, add a new file and give it the same name as its
associated controller action with the .cshtml file extension.

e For Ex - For About action in the Home controller, create an
About.cshtml file in the Views/Home folder:

@4
ViewData["Title"] = "About";

}
<h2>@ViewData["Title"].</h2>

<h3>@ViewData[ "Message" ]</h3>

<p>Use this area to provide additional information.</p>
27



Creating a View

e Razor markup starts with the @ symbol.

* Your can write C# code within Razor code blocks set off by curly
braces ({ ... }).

* You can display values within HTML by simply referencing the
value with the @ symbol. See the contents of the <h2> and <h3>

elements above.

28



How Controllers Specify Views

* Views are typically returned from actions as a ViewResult, which
is a type of ActionResult.

HomeController.cs

public IActionResult About()
{

ViewData["Message"] = "Your application description page.";

return View();

29



How Controllers Specify Views

B <« [ About- WebApplicatior X -+ W _ ] %

é > O fﬁ} localhost ‘i% i‘g ﬁ,_ IL:}

WebApplication1  Home

About.

Your application description page.

Use this area to provide additional information.

© 2017 - WebApplication1
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Passing Data to Views: ViewData & ViewBag

* Views have access to a weakly typed(loosely typed) collection of data.

You can use these for passing small
controllers and views

amounts of data in and out of

» The ViewData property is a dictionary of weakly typed objects.

» The ViewBag property is a wrapper

around ViewData that provides

dynamic properties for the underlying ViewData collection.

* ViewData and ViewBag are dynamica

* ViewData is a ViewDataDictionary obj

ly resolved at runtime.

ect accessed through string keys

31



Ex - ViewData

// HomeController.cs
public class HomeController : Controller {
public IActionResult About() {
ViewData["Message"] = "Your application description page.";

return View();

}
}
// About.cshtml
@{
ViewData["Title"] = "About";
}

<h3>@ViewData[ "Message" ]</h3>

32



Ex - ViewBag

// HomeController.cs
public class HomeController : Controller {
public IActionResult SomeAction() {
ViewBag.Greeting = “Hello";

return View();

}
}
//SomeAction.cshtml
@{
ViewData["Title"] = “My Title";
}

<h3>@ViewBag.Greeting</h3>

33



Razor Syntax

» The biggest advantage of the Razor is the fact that you can mix
client-side markup (HTML) with server-side code (e.g C# or

VB.NET), without having to explicitly jump in and out of the two
syntax types.

* In Razor, you can reference server-side variables etc. by simply
prefixing it with an at-character (@).

<p>Hello, the current date is: @DateTime.Now.ToString()</p>
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Ex - Razor & HTML Encoding

@1

var helloWorld = "<b>Hello, world!</b>":

}
<p>@helloWorld</p>

<p>@Html.Raw(helloWorld)</p>




Ex — Razor Explicit Expressionsc

@1

var name = "John Doe";

}
Hello, @(name.Substring(0,4)).

Your age is: <b>@(37 + 5).</b>
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Ex — Multi-statement Razor blocks

@{

var sum = 32 + 10;
var greeting = "Hello, world!";
var text ="";
for(inti=0;i<3;i++)
{
text += greeting + " The resultis: " + sum + "\n";

}

}
<h2>CodeBlocks</h2>

Text: @text

37



Razor Server-side Comments

e Sometimes you may want to leave comments in your code, or
comment out lines of code temporarily to test things.

@*
Here's a Razor server-side comment

It won't be rendered to the browser

@

38




Razor Server-side Comments

If you're inside a Razor code block, you can even use the regular C#
style comments:
@
@*
Here's a Razor server-side comment
@
// C#t style single-line comment
/*
C# style multiline comment
It can span multiple lines

*/



Razor Syntax — Variables and Expressions

@{
string helloWorldMsg = "Good day";

if(DateTime.Now.Hour >17){
helloWorldMsg = "Good evening";

}
helloWorldMsg +=", world!";

helloWorldMsg = helloWorldMsg.ToUpper();

}
<div> @helloWorldMsg </div>
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Razor Syntax — The if-else statement

@if(DateTime.Now.Year >= 2042)
{

<span>The year 2042 has finally arrived!</span>

¥

else

{

<span>We're still waiting for the year of 2042...</span>

41



@{

List<string> names = new List<string>() {
"VB.NET", "C#", "Java"

s
}
<ul>
@for (int i = @; 1 < names.Count; i++)
{
<li>@names[i]</1i>
}
</ul>
<ul>
@foreach (string name in names)
{
<li>@name</1li>
}

</ul>

Razor Syntax
- Loop
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Understanding Tag Helpers

» Tag Helpers enable server-side code to participate in creating and
rendering HTML elements in Razor files. Tag helpers are a new
feature and similar to HTML helpers, which help us render HTML.

43



Understanding Tag Helpers

Tag Helpers enable server-side code to participate in creating and
rendering HTML elements in Razor files. Tag helpers are similar to
HTML helpers, which help us render HTML.

There are many built-in Tag Helpers for common tasks, such as
creating forms, links, loading assets etc.

Tag Helpers are authored in C#, and they target HTML elements
based on the element name, attribute name, or the parent tag.

For ex, LabelTagHelper can target the HTML <label> element.

Tag Helpers reduce the explicit transitions between HTML and C# in
Razor views.
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Understanding Tag Helpers

* In order to use Tag Helpers, we need to install a NuGet library
and also add an addTagHelper directive to the view or views that

use these tag helpers.

o Let us right-click on your project in the Solution Explorer and
select Manage NuGet Packages....

o Search for Microsoft.AspNet.Mvc.TagHelpers and click the Install
button.

° In the dependencies section, you will see
"Microsoft.AspNet.Mvc.TagHelpers"




Understanding Tag Helpers

Browse Installed Updates NuGet Package Manager: WebApplicationCoreS1

taghelpers X | |:| Include prerelease Package source: |nugetorg -~ 4}

Nl Microsoft AspNetCc&@ nuget.org
Microsoft.AspNetCore.Mvc.TagHelpers @ by Microsoft, 73.7M downlo:  v2.2.0

ASP.MET Core MVC default tag helpers. Contains tag helpers for anchor tags, HTML
input elements, caching, scripts, links (for C55), and more. Version: |Latest stable 2.2.0 |- Install

Microsoft.AspMNetCore.Razor & by Microsoft, 85.5M downloads v2.2.0

Razor 1s a markup syntax for adding server-side logic to web pages. This package
contains runtime components for rendering Razor pages and implementing tag hel...

(») Options

Description

ASP.NET Core MVC default tag helpers. Contains tag
helpers for anchor tags, HTML input elements,
caching, scripts, inks (for C55), and more.

IMad Microsoft.AspNetCore.Razor.Runtime & by Microsoft, 85.3M downloac  v2.2.0

Runtime infrastructure for rendering Razor pages and tag helpers.

Localization.AspNetCore.TagHelpers by AdmiringWorm, 151K download  v0.6.0 This package was built from the source code at
https://github.com/aspnet/Mvc/tree/
ab199bbfbab05583f98 /bae322fb(4566841aaea

Asp.MNet Core Tag Helpers to use when localizing Asp.MNet Core applications instead of
manually injecting ViewlLocator.

LT EAE TN




License Acceptance X

License Acceptance

The following package(s) require that you accept their license terms before
installing.

® You WI” FECEIVe the Microsoft.AspNet.Mvc.TagHelpers Author(s): Microsoft

View License

following dialog box.

* Click on | Accept

By clicking "l Accept,” you agree to the license terms for the package(s) listed
above. If you do not agree to the license terms, click "l Decline.”

| Accept | Decline




Writing your own Tag Helpers

You can also write your own tag helper. You can place it right inside your
application project, but you need to tell the Razor view engine about the tag
helper. By default, they are not just rendered down to the client, even though
these tag helpers look like they blend into the HTML.

Razor will call into some code to process a tag helper; it can remove itself
from the HTML and it can also add additional HTML.

You need to register your tag helpers with Razor, even the Microsoft tag
helpers, in order for Razor to be able to spot these tag helpers in the markup
and to be able to call into the code that processes the tag helper.

The directive to do that is addTagHelper, and you can place this into an
individual view or Viewlmports file.



Form Tag Helper

* The Form Tag Helper is bound to the HTML <form> element.

o provides several server-side attributes which help us to
manipulate the generated HTML.
 Some of the available attributes are

o asp-controller: The name of the MVC controller.to use
o asp-action: The name of the MVC Controller action.method to use

o asp-area: The name of the Controller Area to use




Form Tag Helper

EX

<form asp-controller="Home" asp-action="Create">

The above code translated into

<form method="post" action="/Home/Create">
<input name="__ RequestVerificationToken" type="hidden"

value="CfDI8P1Iso5McDBOjgPkVg904mnNiAE8UOHkV1A9e -
Mtc76u7fSjCnoy909Co49eGlbyJx

pp-nYphF_XkOrPo@tTGdygc2H8nCtZCcGURMZOUFO1fPOg5jRARXTHXNb8N6YYADtdQSN
JTtXtYsir8GCWgzM" />

</form>




Form Tag Helper

Label tag Helper :
<label asp-for="@Model.Name"></label>
Which translates into <label for="Name">Name</label>

Using @Model keyword is optional here. You can directly use the model property name as
shown below.

<label asp-for="Name"></label>

Input Tag Hel Per - Similarly, the Input tag Helper is applied to the input HTML element.

<input asp-for="Name"/>
Which translates into <input type="text" id="Name" name="Name" value=""/>

> The type, id & name attributes are automatically derived from the model property type & data
annotations applied on the model property



Form Tag Helper

EX

<form asp-controller="Home" asp-action = "Create">
<label asp-for = "Name"></label>
<input asp-for = "Name"/>

<label asp-for = "Rate"></label>
<input asp-for = "Rate"/>

<label asp-for = "Rating"></label>
<input asp-for = "Rating"/>

<input type="submit" name="submit"/>

</form>
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List of Built-in Tag Helpers

Form Tag Helper <Form>

Anchor Tag Helpers Bk

Image Tag Helper <img>

Input Tag Helper <input>
Label Tag Helper <label>

Link Tag Helper <link>

asp-action, asp-all-route-data, asp-area, asp-
controller, asp-protocol, asp-route, asp-route-

asp-action, asp-all-route-data, asp-area, asp-
controller, asp-Protocol, asp-route, asp-route-

append-version

for

For

href-include, href-exclude, fallback-href, fallback-test-
value, append-version
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List of Built-in Tag Helpers

Options Tag Helper <select>
Partial Tag Helper <partial>

Script Tag Helper <script>

Select Tag Helper <select>
Textarea Tag Helper <textarea>

Tag Helper
Tag Helper

TogHelper | Targets | Awrbutes ________

asp-for, asp-items

name, model, for, view-data

src-include, src-exclude, fallback-src, fallback-src-
include, fallback-src-exclude
falloack-test, append-version

for, items

for

validation-for

validation-summary
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Model

» The Model in an MVC application should represent the current state of the
application, as well as business logic and/or operations.

e A very important aspect of the MVC pattern is the Separation of Concerns
(SoC). SoC is achieved by encapsulating information inside a section of code,
making each section modular, and then having strict control over how each
module communicates. For the MVC pattern, this means that both the View
and the Controller can depend on the Model, but the Model doesn't depend
on neither the View nor the Controller.

* As mentioned, the Model can be a class already defined in your project, or it
can be a new class you add specifically to act as a Model. Therefore, Models
in the ASP.NET MVC framework usually exists in a folder called "Models".
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ViewModels

» There are, however, a lot of situations where you may want to create
a specific ViewModel for a specific View. This can be to extend or
simplify an existing Model, or because you want to represent
something in a View that's not already covered by one of your
models.

* ViewModels are often placed in their own directory in your project,
called "ViewModels".

» Some people also prefer to postfix the name of the class with the
word ViewModel, e.g. "AddressViewModel" or "EditUserViewModel".
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When to use ViewModel?

* To represent something in a View that's not already contained by an
existing Model: When you pass a Model to a View, you are free to pass
e.g. a String or another simple type, but if you want to pass multiple
values, it might make more sense to create a simple ViewModel to hold
the data, like this one:
public class AddressViewModel
{

public string StreetName { get; set; }
public string ZipCode { get; set; }
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When to use ViewModel?

* To access the data of multiple Models from the same View: This is
relevant in a lot of situations, e.g. when you want to create a FORM where
you can edit the data of multiple Models at the same time. You could then
create a ViewModel like this:

public class EditItemsViewModel

{
public ModellType Modell { get; set; }

public Model2Type Model2 { get; set; }
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When to use ViewModel?

To simplify an existing Model: Imagine that you have a huge class with information
about a user. Perhaps even sensitive information like passwords. When you want to
expose this information to a View, it can be beneficiary to only expose the parts of it
you actually need. For instance, you may have a small widget showing that the user is
logged in, which username they have and for how long they have been logged in. So

instead of passing your entire User Model, you can pass in a much leaner ViewModel,
designed specifically for this purpose:

public class SimpleUserInfoViewModel {
public string Username { get; set; }

public TimeSpan LoginDuration { get; set; }
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When to use ViewModel?

*» To extend an existing Model with data only relevant to the View: On the other hand,
sometimes your Model contains less information than what you need in your View. An
example of this could be that you want some convenience properties or methods
which are only relevant to the View and not your Model in general, like in this example
where we extend a user Model (called WebUser) with a LoginDuration property,
calculated from the LastLogin DateTime property already found on the WebUser class:

public class WebUser

{
public DateTime LastLogin { get; set; }
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From there on there are two ways of doing things: You can either extend this class (inherit from it)
or add a property for the WebUser instance on the ViewModel. Like this:

public class UserInfoViewModel {
public WebUser User { get; set; }
public TimeSpan LoginDuration

{

get { return DateTime.Now - this.User.LastlLogin; }

}
Or like this:

public class ExtendedUserInfoViewModel : WebUser {
public TimeSpan LoginDuration

{

get { return DateTime.Now - this.LastLogin; }
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Model Binding in ASP.NET Core

The Model Binding extracts the data from an HTTP request and provides them to the
controller action method parameters. The action method parameters may be simple
types like integers, strings, etc. or complex types such as Student, Order, Product, etc.

The controller action method handle the incoming HTTP Request.
Our application default route template ({controller=Home}/{action=Index}/{ld?})

When you load this url - , shows the Details
action method.

[public ViewResult Details(int Id)

{

var studentDetails = listStudents.FirstOrDefault(std => std.StudentId == Id);
return View(studentDetails);
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Using Model Binding

e In Model Folder, create a class WebUser.cs

public class WebUser

{
public string FirstName { get; set; }
public string LastName { get; set; }
}
e |n Controller Folder, create a new Controller as UserController.cs and add action method as
follows:
[HttpGet]
public IActionResult SimpleBinding()
{

return View(new WebUser() { FirstName = "John", LastName = "Doe" });
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By letting our View know what kind of Model it can expect, with the @model directive, we can
now use various helper methods (more about those later) to help with the generation of a
FORM:
In View Folder, create a file SimpleBinding.cshtml
@using(var form = Html.BeginForm())
{
<div>
@Html.LabelFor(m => m.FirstName)
@Html.TextBoxFor(m => m.FirstName)
</div>

<div>
@Html.LabelFor(m => m.LastName)
@Html.TextBoxFor(m => m.LastName)
</div>
<input type="submit" value="Submit" />
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The result will be a very generic-looking FORM, but with labels and textboxes

designated to host the properties of your Model: _. __
FirstName |John

LastName Doe
Subrmit

By default, the FORM will be posted back to the same URL that delivered it, so to
handle that, we need a POST-accepting Controller method to handle the FORM

submission:

[HttpPost]
public IActionResult SimpleBinding(WebUser webUser)

{
//TODO: Update in DB here...

return Content($"User {webUser.FirstName} updated!");

23



Data Annotations

Data Annotations (sometimes referred to as Model Attributes), which basically allows
you to add meta data to a property.

The cool thing about DataAnnotations is that they don't disturb the use of your Models
outside of the MVC framework.

When generating the label, the name of the property is used, but property names are
generally not nice to look at for humans. As an example of that, we might want to
change the display-version of the FirstName property to "First Name".

public class WebUser

{
[Display(Name="First Name")]

public string FirstName { get; set; }
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Model Validation

They will allow you to enforce various kinds of rules for your properties, which will be used in

your Views and in your Controllers, where you will be able to check whether a certain Model is

valid in its current state or not (e.g. after a FORM submission).

» Let’s add just a couple of basic validation to the WebUser
public class WebUser {

[Required]
[StringLength(25)]
public string FirstName { get; set; }
[Required]
[StringLength(50, MinLength(3)]
public string LastName { get; set; }
[Required]
[EmailAddress]
public string MailAddress { get; set; }
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Model Validation

* Notice how the three properties have all been decorated with DataAnnotations.

» First of all, all properties have been marked with the [Required] attribute, meaning that
a value is required - it can't be NULL.
o [StringLength] attribute make requirements about the maximum, and in one case

minimum, length of the strings. These are of course particularly relevant if your Model
corresponds to a database table, where strings are often defined with a maximum

length.

* For the last property, [EmailAddress] attribute ensure that the value provided looks like

an e-mail adress.
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@model HelloMVCWorld.Models.WebUser
@using(var form = Html.BeginForm()) {

<div> I
@Html.LabelFor(m => m.FirstName) n \IC)llr.
@Html.TextBoxFor(m => m.FirstName) ‘\/iea‘n’

</div>

<div> Page

@Html.LabelFor(m => m.LastName)
@Html.TextBoxFor(m => m.LastName)
</div>
<div>
@Html.LabelFor(m => m.MailAddress)
@Html.TextBoxFor(m => m.MailAddress)
</div>

<input type="submit" value="Submit" />
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public class ValidationController : Controller

( In your Controller
[HttpGet]
public IActionResult SimpleValidation() e |n POST action, we check the
{ IsValid  property of the
return View(); ModelState object. Depending
} on the data submitted in the
[HttpPost] FORM, it will be either true or
public IActionResult SimpleValidation(WebUser webUser) false, based on the validation
{ rules we defined for the Model
if(ModelState.IsValid) (VVetHJser)

return Content("Thank you!"); . o
e With this in place, you can now

prevent a Model from being
saved, e.g. to a database,
unless it's completely valid.

else

return Content("Model could not be validated!");
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@model HelloMVCWorld.Models.WebUser
@using(var form = Html.BeginForm()) {
<div>
@Html.LabelFor(m => m.FirstName)
@Html.TextBoxFor(m => m.FirstName)
@Html.ValidationMessageFor(m => m.FirstName)
</div>
<div>
@Html.LabelFor(m => m.LastName)
@Html.TextBoxFor(m => m.LastName)
@Html.ValidationMessageFor(m => m.LastName
</div>
<div>
@Html.LabelFor(m => m.MailAddress)
@Html.TextBoxFor(m => m.MailAddress)
@Html.ValidationMessageFor(m => m.MailAddress)
</div>
<input type="submit" value="Submit" />

}

Displaying

validation errors
Let’s extend our FORM so that
it can display error messages to
the user. We can use helper
method -
ValidationMessageFor().

It will simply output the error
message related to the field, if
there is one - otherwise,
nothing will be outputted.
Here's the extended version of
our FORM:
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public class ValidationController : Controller

{ In your Controller
[HttpGet]
public IActionResult SimpleValidation() e make sure that once the FORM
{ is submitted, and if there are
return View(); validation errors, we return the
} FORM to the user, so that they
[HttpPost]

can see and fix these errors.
public IActionResult SimpleValidation(WebUser webUser) '
e We do that in our Controller,

{
if(ModelState.IsValid) simply by returning the View
return Content("Thank you!"); and the current Model state, if
else there are any validation errors:
return View(webUser);
}
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Try Submitting the Form

Try submitting the FORM with empty fields, you should be immediately returned to
the FORM, but with validation messages next to each of the fields.

FirstiName The FirstName field 1s required.

Last™Name The LastName field 15 required.

MaitlAddress The MailAddress field 1s required.
Submit

If you try submitting the FORM with a value that doesn't meet the Stringlength
requirements, you will notice that there are even automatically generated error
messages for these as well. For instance, if you submit the FORM with a LastName

that's either too long or too short, you will get this message:
The field LastName must be a string with a minimum length of 3 and a maximum
length of 50.
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What if you want more control of these messages?

» But No problem, they can be overridden directly in the DataAnnotations of the
Model. Here's a version of our Model where we have applied custom error messages:
public class WebUser {
[Required(ErrorMessage = "You must enter a value for the First Name field!")]

[StringlLength(25, ErrorMessage = "The First Name must be no longer than 25
characters!")]
public string FirstName { get; set; }

[Required(ErrorMessage = "You must enter a value for the Last Name field!")]

[StringlLength(50, MinimumLength = 3, ErrorMessage = "The Last Name must be between 3
and 50 characters long!")]
public string LastName { get; set; }

[Required(ErrorMessage = "You must enter a value for the Mail Address field!")]
[EmailAddress(ErrorMessage = "Please enter a valid e-mail address!")]

public string MailAddress { get; set; }

32



@model HelloMVCWorld.Models.WebUser
@using(var form = Html.BeginForm())

{
@Html.ValidationSummary()
<div>
@Html.LabelFor(m => m.FirstName)
@Html.TextBoxFor(m => m.FirstName)
</div>
<div>
@Html.LabelFor(m => m.LastName)
@Html.TextBoxFor(m => m.LastName)
</div>
<div>
@Html.LabelFor(m => m.MailAddress) S
@Html.TextBoxFor(m => m.MailAddress)
</div>
o
<input type="submit" value="Submit" />
}

Displaying a validation
summary

« You must enter a value for the First Name field!
* The Last Name must be between 3 and 30 characters long!
¢ Please enter a valid e-mail address!

FirstName

LastName aa

MailAddress test
Submit

Use ValidationSummary() method found
on the Html helper object:

Now, When the FORM is submitted, It will
be returned with validation errors
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Types of Model Validation DataAnnotations

» [Required] - Specifies that a value needs to be provided for this property

o [StringLength] - Allows you to specify at least a maximum amount of characters. We
can also add Minumum Length as well.

[StringlLength(50, MinimumLength = 3)]
* [Range] - specify a minimum and a maximum value for a numeric property (int, float,
double etc.)

[Range(1, 100)]
» [Compare] - allows you to set up a comparison between the property

[Compare("MailAddressRepeated") ]
public string MailAddress { get; set; }
public string MailAddressRepeated { get; set; }

34



URL Routing and Features

* The Routing is the Process by which ASP.NET Core inspects the incoming
URLs and maps them to Controller Actions.

e |t also used to generate the outgoing URLs.

e This process is handled by the Routing Middleware. The Routing
Middleware is available in Microsoft.AspNetCore.Routing Namespace .

* The Routing has two main responsibilities:
1. It maps the incoming requests to the Controller Action

2. Generate an outgoing URLs that correspond to Controller actions.
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Routing in ASP.NET MVC Core

Routing in ASP.NET MVC Core

Controller

HTTP
Request Chooses
y Routing

Mapping the Incoming Requests

> Action

Controller

Constructing the URLs

( )
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How Routing works in ASP.NET MVC Core

How Routing Works in ASP.NET Core

| Previous Middleware I

HTTP Request

Y

| Parse URLs I

Locate the matching route
in the Routes Collection

Routing Middleware

> | Next Middleware I

To Router Handler




How Routing works in ASP.NET MVC Core

e When the Request arrives at the Routing Middleware it does the

following.
1. It Parses the URL.
2. Searches for the Matching Route in the RouteCollection.
3. If the Route found then it passes the control to RouteHandler.

4. If Route not found, it gives up and invokes the next Middleware.
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How Routing works in ASP.NET MVC Core

What is a Route

* The Route is similar to a roadmap. We use a roadmap to go to our
destination. Similarly, the ASP.NET Core Apps uses the Route to go to the
controller action.

» The Each Route contains a Name, URL Pattern (Template), Defaults and
Constraints. The URL Pattern is compared to the incoming URLs for a match.
An example of URL Pattern is {controller=Home}/{action=Index}/{id?}

* The Route is defined in the Microsoft.AspNetCore.routing namespace .
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How Routing works in ASP.NET MVC Core

What is a Route Collection
» The Route Collection is the collection of all the Routes in the Application.

e An app maintains a single in-memory collection of Routes. The Routes
are added to this collection when the application starts.

* The Routing Module looks for a Route that matches the incoming request
URL on each available Route in the Route collection.

e The Route  Collection is  defined in  the namespace
Microsoft.AspNetcore.routing.
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How Routing works in ASP.NET MVC Core

What is a Route Handler

The Route Handler is the Component that decides what to do with the
route.

When the routing Engine locates the Route for an incoming request, it
invokes the associated RouteHandler and passes the Route for further

processing. The Route handler is the class which implements the
IRouteHandler interface.

In the ASP.NET Core, the Routes are handled by the MvcRouteHandler.
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How Routing works in ASP.NET MVC Core

MVCRouteHandler

Default Route Handler for the ASP.NET Core MVC Middleware. The
MVCRouteHandler is registered when we register the MVC Middleware
in the Request Pipeline. You can override this and create your own
implementation of the Route Handler.

defined in the namespace Microsoft.AspnetCore.Mvc.

The MVCRouteHandler is responsible for invoking the Controller Factory,
which in turn creates the instance of the Controller associated the Route.

The Controller then takes over and invokes the Action method to
generate the View and Complete the Request.
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How to setup Routes

* There are two different ways by which we can set up routes.
1. Convention-based routing
2. Attribute routing

Convention-based routing

» The Convention based Routing creates routes based on a series of
conventions, defined in the ASP.NET Core Startup.cs file.

Attribute routing

» Creates routes based on attributes placed on controller actions.

The two routing systems can co-exist in the same system.
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How to setup Routes

The Convention based Routes are configured in t
the Startup class. The Routing is handled by t
ASP.NET MVC adds the routing Middleware to t

when using the app.UseMVC or app.UseMvcWith

MapRoute Api

app.Usebvc (routes=>»

1

routes . MapRoute

“default”, > Name of the Route

“{controller=Home/{action=Index}/{id? "), — U
Fattern

ne Configure method of
ne Router Middleware.

ne Middleware pipeline
DefaultRoute.

RL
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URL Patterns

» The Each route must contain a URL pattern. This Pattern is compared to
an incoming URL. If the pattern matches the URL, then it is used by the
routing system to process that URL.

URL Pattern

{controller=Home}ffaction=Index}/{id?

b I

L i
Segments , .
URL Parameter 7Is Optional

Controller Default Value
for Controller
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The URL Pattern {controller=Home}/{action=Index}/{id?} Registers route
where the first part of the URL is Controller, the second part is the action

method to invoke on the controller. The third parameter is an additional
data in the name of id.

URL Matching

] ] . {controller=Home}/{action=Index}/{id?}
The Each segment in the incoming

URL is matched to the corresponding
segment in the URL Pattern.

www.Example.com/Product/List

{controller=Home}/{action=Index}/{id?}

has three segments. The last one is

optional.

First Segment is mapped to the first segment
in the pattern
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Web API Applications

Before ASP.NET Web API core, the two-different framework MVC and
Web API were pretty much similar.

Both used to support Controller and action methods. In earlier version,
the main purpose of Web APl was to make REST API calls and there were
view engine like Razor.

On the other hand, MVC was designed for HTML front ends to
communicate to backend in a standard a web application. However,
when ASP.NET Web API core was released, the main target was to
support JSON based REST API. It combines the key feature of both MVC
and old Web API framework.
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ASP.NET Core Web API Architecture

ASP.NET Web API is mainly based on the MVC architecture. The .NET
framework and .NET Core also share a number of APIs.

.NET Framework| Shared| .NET Core API
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New Features in ASP.NET Core Web API

Cross Platform - ASP.NET Web API Core is cross-platform; therefore, it is
suitable for running on any platform like Windows, Mac, or Linux. Earlier
ASP.NET applications were not able to run on Linux and Mac operating
system.

Backward Compatibility - For existing application, ASP.NET Web API Core
supports two framework.

Faster - ASP.NET Web API Core is much faster than previous versions

Static Content - wwwroot folder contain all the static content e.g. js, css,
Images.
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Creating Web API in ASP.NET Core

* Create the controller that have 3 things:

> should have [ApiController] attribute on them. This attribute tells that
the controller will serve HTTP APl Responses.

o derive from ControllerBase class instead of Controller class.

o should have attribute routing applied on them like
[Route("someUrl/[controller]")].

o The controller of a Web API

[ApiController]
[Eoute("someURL [ [controller]")]

IOO kS |Ik€: public class ExampleController : ControllerBase




API Controllers

API Controller is just a normal Controller, that allows data in the model to
be retrieved or modified, and then deliver it to the client. It does this
without having to use the actions provided by the regular controllers.

The data delivery is done by following a pattern known by name as REST.
REST Stands for REpresentational State Transfer pattern, which contains 2
things:

> Action Methods which do specific operations and then deliver some data to the

client. These methods are decorated with attributes that makes them to be invoked
only by HTTP requests.

°  URLs which defines operational tasks. These operations can be — sending full or
part of a data, adding, deleting or updating records. In fact it can be anything.
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API Controller

MVC and API controllers both derive from the Controller class, which

derives from ControllerBase:

public class MyMvc20Controller : Controller {}
[Route("api/[controller]")]
public class MyApi2@Controller : Controller {}

As of Core 2.1 (and 2.2), the template-generated classes look a little
different, where a Web controller is a child of the Controller class and an

API controller is a child of ControllerBase.

public class MyMvc2lController : Controller {}
[Route("api/[controller]™)]
public class MyApi2lController : ControllerBase {}
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APl Controller

This can be expressed in the table below:

Namespace Microsoft.AspNetCore.Mvc

Common parent ControllerBase (Abstract Class)

MVC Controller parent Controller: ControllerBase

MVC Controller MyMvcController: Controller

53



JSON

The new built-in JSON support, System.Text.Json, is high-performance,
low allocation, and based on Span<byte>.

The System.Text.Json namespace provides high-performance, low-
allocating, and standards-compliant capabilities to process JavaScript
Object Notation (JSON), which includes serializing objects to JSON text
and deserializing JSON text to objects, with UTF-8 support built-in.

It also provides types to read and write JSON text encoded as UTF-8, and
to create an in-memory document object model (DOM) for random
access of the JSON elements within a structured view of the data.
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Adding JSON Patch To Your ASP.Net Core Project

 Run Package Manager and install JSON Patch Library with command:
o Install-PackageMicrosoft.AspNetCore.JsonPatch

public class Person

* Write in your controller {
public string FirstName{get:;set:;}

[RDUtE {"api;’ [{:DﬂtrDllEI] 'I'F} ] pu_bll-': string Lastﬂame{get; setr}

public class PersonController : Controller (|
private readonly Person defaultPerson =newPerson
{
FirstName="Jim",
LastName="Smith"
17
[HEtpPatch ("update™) ]
public Person Patch([FromBody]JsonPatchDocument<Person> personPatch) |
personPatch.ApplyTo( defaultPerson);
return defaultPerson;
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Adding JSON Patch To Your ASP.net Core Project

* In above example we are just using a simple object stored on the
controller and updating that, but in a real APl we will be pulling the data
from a datasource, applying the patch, then saving it back.

* When we call this endpoint with the following payload :

[{"op":"replace”, "path":"FirstName", "value":"Bob"}]

* We get the response of :

{"firstName" :"Bob","lastName":"Smith"}

first name got changed to Bob!




DEPENDENCY INJECTION AND IOC CONTAINERS

ASP.NET Core is designed from scratch to support Dependency Injection.

ASP.NET Core injects objects of dependency classes through constructor
or method by using built-in 1oC container.

ASP.NET Core framework contains simple out-of-the-box IoC container
which does not have as many features as other third party loC
containers. If you want more features such as auto-registration, scanning,
interceptors, or decorators then you may replace built-in 10C container
with a third party container.
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BUILT-IN I0C CONTAINER

 The built-in container is represented by IServiceProvider implementation
that supports constructor injection by default. The types (classes)
managed by built-in loC container are called services.

 There are basically two types of services in ASP.NET Core:

Framework Services: Services which are a part of ASP.NET Core framework such
as |ApplicationBuilder, IHostingEnvironment, ILoggerFactory etc.

Application Services: The services (custom types or classes) which you as a
programmer create for your application.

° In order to let the loC container automatically inject our application
services, we first need to register them with loC container.
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Registering Application Service

Consider the following example of simple ILog interface and its
implementation class. We will see how to register it with built-in l1oC container
and use it in our application.

public interface ILog {
void info(string str);

}

class MyConsoleLogger : ILog {
public void info(string str)

{

Console.WriteLine(str);
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Registering Application Service

o ASP.NET Core allows us to register our application services with loC container,
in the ConfigureServices method of the Startup class. The ConfigureServices

method includes a parameter of IServiceCollection type which is used to
register application services.

o Let's register above ILog with 10C container in ConfigureServices() method as
shown below. Example: Register Service

public class Startup {
public void ConfigureServices(IServiceCollection services) {
services.Add(new ServiceDescriptor(typeof(ILog),

new MyConsoleLogger()));
} // other code removed for clarity..
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Registering Application Service

In above ex:

Add() method of IServiceCollection instance is used to register a service with
an loC container.

ServiceDescriptor is used to specify a service type and its instance. We have
specified ILog as service type and MyConsolelLogger as its instance. This will
register ILog service as a singleton by default.

Now, an loC container will create a singleton object of MyConsoleLogger class
and inject it in the constructor of classes wherever we include ILog as a
constructor or method parameter throughout the application.

Thus, we can register our custom application services with an loC container in
ASP.NET Core application. There are other extension methods available for
quick and easy registration of services.
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Understanding Service Lifetime for Registered Service

1.

Built-in 10C container manages the lifetime of a registered service type. It
automatically disposes a service instance based on the specified lifetime.

The built-in 1oC container supports three kinds of lifetimes:

Singleton: 10C container will create and share a single instance of a
service throughout the application's lifetime.

Transient: The loC container will create a new instance of the specified

service type every time you ask for it.

Scoped: 10C container will create an instance of the specified service
type once per request and will be shared in a single request.
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Understanding Service Lifetime for Registered Service

» The following example shows how to register a service with different lifetimes.
» Example: Register a Service with Lifetime
public void ConfigureServices(IServiceCollection services)
{
// singleton
services.Add(new ServiceDescriptor(typeof(ILog), new MyConsoleLogger()));
services.Add(new ServiceDescriptor(typeof(ILog), typeof(MyConsoleLogger),
Servicelifetime.Transient)); // Transient
services.Add(new serviceDescriptor(typeof(ILog), typeof(MyConsoleLogger),
ServicelLifetime.Scoped)); // Scoped




|OC Containers

o ASP.NET Core framework includes built-in loC container for automatic dependency
injection. The built-in loC container is a simple yet effective container.

» The followings are important interfaces and classes for built-in loC container:
Interfaces

1. IServiceProvider

2. IServiceCollection
Classes

1. ServiceProvider

2. ServiceCollection

3. ServiceDescription

4. ServiceCollectionServiceExtensions

5. ServiceCollectionContainerBuilderExtensions
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|OC Containers
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|OC Containers

IServiceCollection

we can register application services with built-in l1oC container in the Configure
method of Startup class by using IServiceCollection. IServiceCollection
interface is an empty interface. It just inherits IList<servicedescriptor>.

The ServiceCollection class implements IServiceCollection interface.

So, the services you add in the IServiceCollection type instance, it actually
creates an instance of ServiceDescriptor and adds it to the list.

IServiceProvider

|IServiceProvider includes GetService method.

The ServiceProvider class implements IServiceProvider interface which returns
registered services with the container. We cannot instantiate ServiceProvider
class because its constructors are marked with internal access modifier.
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|OC Containers

ServiceCollectionServiceExtensions

» The ServiceCollectionServiceExtensions class includes extension methods related to
service registrations which can be used to add services with lifetime. AddSingleton,
AddTransient, AddScoped extension methods defined in this class.

ServiceCollectionContainerBuilderExtensions

e ServiceCollectionContainerBuilderExtensions class includes BuildServiceProvider
extension method which creates and returns an instance of ServiceProvider.

» There are three ways to get an instance of IServiceProvider:
o Using |ApplicationBuilder
o Using HttpContext

o Using IServiceCollection
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|OC Containers

Using IApplicationBuilder
® \We can get the services in Configure method using |ApplicationBuilder's
ApplicationServices property as shown below.

public void Configure(IServiceProvider pro, IApplicationBuilder app,
IHostingEnvironment env)
{
var services = app.ApplicationServices;
var logger = services.GetService<ILog>() }
//other code removed for clarity
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|OC Containers

Using HttpContext

var services = HttpContext.RequestServices;

var log = (ILog)services.GetService(typeof(ILog));

Using IServiceCollection

public void ConfigureServices(IServiceCollection services)

{

var serviceProvider = services.BuildServiceProvider();
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Unit5

Working with Database




Database

A database is an organized collection of structured information, or data,
typically stored electronically in a computer system.

A database is usually controlled by a database management system (DBMS).

The main purpose of the database is to operate a large amount of
information by storing, retrieving, and managing data.

Data within the most common types of databases in operation today is
typically modeled in rows and columns in a series of tables to make
processing and data querying efficient.

Most databases use Structured Query Language (SQL) for writing and
guerying data

There are many databases available like SQL Server, Oracle, MySQL,
MongoDB, PostgreSQL, Sybase, Informix, etc.
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SQL Server

o SQL Server is a relational database management system, or
RDBMS, developed and marketed by Microsoft.

e Similar to other RDBMS software, SQL Server is built on top of
SQL, a standard programming language for interacting with the
relational databases.

e SQL server is tied to Transact-SQL, or T-SQL, the Microsoft’s
implementation of SQL that adds a set of proprietary
programming constructs.




Download and Setup SQL Server

e Go to URL:

» Download Free Edition of MS SQL Server. Either Developer or
Express Edition

* During installation, remember these:
> In Instance Configuration Screen, choose Default Instance

> In Database Engine Configuration Screen, choose Mixed Mode(SQL
Server authentication and Windows Authentication) and Enter

Password

> Then follow Next Button.



https://www.microsoft.com/en-in/sql-server/sql-server-downloads

Database Engine Configuration

specrfy Dotabase Engine authenbcation secunty mode, administrators and data directones.

Setup Support Rules
Installation Type

Product Key

Licensze Terms

Setup Rale

Feature Seldection

Installation Rules

Instance Cnnllgural:inn

Disk Space Feguirements
server {onfiguration

Database Engine Configuration
Emror Reparting

Installation Configuration Rules
Readhy to Install

Installation Progress

Complete

server Configuration | Data Directories
Specify the authentication mode and adminestrators for the Databass Engane.

Authentication Mode
() Windows authentication mode

() Mixed Meade (S0L Server suthentication and Windoves suthentication)
Speacify the password for the SOL Sarver system administrator (sa) account,
Enter password
Confirm passwornd:
Specify SOL Server administrators
. S0L Server adrminiirabors

have unrestricted aceeis
ta the Databaze Engine.

Add Current Lsar ddd... H=maove

< Back Maxt » Cancel Help




Install SQL Sever Management Studio

e Get SSMS from this url -

e |nstall SSMS

o After install, search Microsoft SQL Server Management Studio and
run

e You will see the screen as shown.

e On Authentication, Select SQL Server Authentication. For User name
enter sa and for password, enter the one that use provide during
installation.
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https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-2017

I;LF Connect to Server

SQL Server

I Server type: Database Engine
| Server name:
| Authentication” Windows Authentication

!

Connect Cancel Help Options >>




ADO.NET Basics

* ADO stands for Microsoft ActiveX Data Objects.

» The ADO.NET is one of the Microsoft’s data access technology which is used to
communicate between the .NET Application (Console, WCF, WPF, Windows,

MVC, Web Form, etc.) and data sources such as SQL Server, Oracle, MySQL, XML
document, etc.

* |t has classes and methods to retrieve and manipulate data.

* The following are a few of the .NET applications that use ADO.NET to connect to
a database, execute commands and retrieve data from the database.
o ASP.NET Web Applications
> Console Applications

> Windows Applications.




2 Types of Connection Architectures

1. Connected architecture:

o the application remains connected with the database
throughout the processing.

2. Disconnected architecture:

> the application automatically connects/disconnects during the
processing.

> The application uses temporary data on the application side
called a DataSet.




Understanding ADO.NET and its class library

K Dot Net \

Applications

Web

Console

k Any Other. . j

ADO. NET

\

System.Data.SqlClient

System.Data.OracleClient| >

Windows >

System.Data.OleDb | >
System.Data.Odbc \ -—>

Connection

Command \
DataReader \

DataAdaptor

Data Set

\_

-~

~

>

SQL Server

Oracle

OleDb

Odbc

Pther Data Source+

"

—

|
J
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Important Classes in ADO.NET

Connection Class
Command Class
DataReader Class
DataAdaptor Class
DataSet Class

A A

Connection Class
* In ADO.NET, we use connection classes to connect to the database.

» These connection classes also manage transactions and connection
pooling. »




Important Classes in ADO.NET

Command Class

provides methods for storing and executing SQL statements and Stored
Procedures. Various commands that are executed by the Command Class:

a. ExecuteReader:
o Returns data to the client as rows.

> This would typically be an SQL select statement or a Stored Procedure
that contains one or more select statements. T

° this method returns a DataReader object that can be used to fill a
DataTable object or used directly for printing reports and so forth.
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Important Classes in ADO.NET

DataReader Class
e The DataReader is used to retrieve data.

* |t is used in conjunction with the Command class to execute an SQL Select
statement and then access the returned rows.

DataAdapter Class
» The DataAdapter is used to connect DataSets to databases.

o The DataAdapter is most useful when using data-bound controls in
Windows Forms, but it can also be used to provide an easy way to manage
the connection between your application and the underlying database
tables, views and Stored Procedures.

13




Important Classes in ADO.NET

DataSet Class
» The DataSet is essentially a collection of DataTable objects.

* In turn each object contains a collection of DataColumn and
DataRow objects.

» The DataSet also contains a Relations collection that can be used
to define relations among Data Table Objects.

14



Connect to a Database using ADO.NET

To create a connection, we have to use the connection strings.

A connection string is required as a parameter to SQLConnection.

A ConnectionString is a string variable (not case sensitive).

This contains key and value pairs:Provider, Server, Database, User Id and

Password as in the following:

Server="name of the server or IP Address of the server"
Database="name of the database™

UserId="user name who has permission to work with database"
Password="the password of User Id"

* Example - SQL Authentication

string constr="server=. ;database=dbl;user id=sa;password=yourpassword";

15



How to connect, retrieve and display data from a database

o nNoe

O 0 N o U

Create a SglConnection object using a connection string.
Handle exceptions.
Open the connection.

Create a SQLCommand. To represent a SQLCommand like (select * from
studentdetails) and attach the existing connection to it. Specify the type of
SQLCommand (Text/StoredProcedure).

Execute the command (use ExecuteReader).

Get the Result (use SqlDataReader). This is a forwardonly/readonly data object.
Process the result

Display the result

Close the connection

16



Create a Database in SQL Server

* Create Database using CREATE DATABASE statement
Syntax: CREATE DATABASE database _name;
EX: CREATE DATABASE TeStDb; Object Explorer * I X

Connect~ ¥ *¥ Yo

‘ create Database USing ObjeCt Explorer = WA localhost (SOL Server 14.0.2002.14 - sa)
* Right Click the Database, choose New Database ﬂ

Syster Mew Database...

[
Datab Lg”
* Enter name for the database as TestDb g Bikest | Atteche
. Th OK g TestD Restore Database...
en Security Restore Files and Filegroups...
Server Ob _
. Filter
Rephcatic
PolyBase Deploy Data-tier Application...
Always O Import Data-tier Application...
Managen
Integratio Start Powershell
3 SOL Serve Reports
AEvent Pr
Refresh
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Create a Table in SQL Server
* Create Table using CREATE TABLE statement

Syntax: CREATE TABLE <Table_Name> Colurmn Marme Data Fype
Ex: )7 1D int
CREATE TABLE AddressBook ( Narme varchar(100]
ID int PRIMARY KEY IDENTITY (1, 1), Address varchar(100)
Name va rchar(lOO), Phone varchar(30}
Address varchar(100),
Phone varchar(50)
) Column Properties
- Create Table using Object Explorer =21 .
* Right Click Table, choose New > Table Li'fifffi'E':_t_';'lwcl_im EZ
* Enter Column Name and DataType v Identity Specification Ves
* Set Primary Key and Auto Increment for ID Column (Is Identity) Ves
* Save Table with name as AddressBook Identity Increment 1
|dentity Seed 1
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EX Showing Connection, Command

string name = "Name 1";
string address = "Address 17;
string phone = "9881000600" ,

string connStr = "Data Source=AM;Initial Catalﬂg=TEStDbLU5EP ID=sa;Password=12345";
SglConnection conn = new SglConnection(connStr);

string sgl = "Insert into AddressBook wvalues (" + name + "', ""
+ address + "',"'" + phone + "")";

SglCommand cmd = new SglCommand(sgl, conn);

conn.0Open();

cmd . ExecuteNonQuery();

conn.Close();
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EX — Reading Data with SqlDataAdapter & DataSet

string connStr = "Data Source=.;Initial Eatalng=Te5tDth5er ID=sa;Password=123456";
SgqlConnection conn = new SglConnection{connStr);

string sgl = "Select * from AddressBook”™;

SqlDataAdapter da = new SglDataAdapter(sql, conn);

DataSet ds = new DataSet();
da.Fill(ds);

GridViewl.DataSource = ds;
GridViewl.DataBind();
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EX Read Data Using SqlDataReader

string connStr = "Data Source=.;Initial Catalog=TestDb;User ID=sa;Password=123456";
S5glConnection conn = new SglConnection(connStr);

string sgl = "Select * from AddressBook™;

5glCommand cmd = new 5glCommand{sgl, conn);

| ist<MyAddressBook> books = new List<MyAddressBook>();
conn.0Open();

SqlDataReader dr = cmd.ExecuteReader();
while(dr.Read())| class MyAddressBook

{ {
MyAddressBook b = new MyAddressBook();
b.ID = (int)dr[@];

1 reference
public int ID { get; set; }

1 reference

b.Name = dr["Name"].ToString(); public string Name { get; set; }
b.Address = dr["Address"].ToString(); 1 reference
b.Phone = dr["Phone”].ToString(); public string Address { get; set; }
books.Add(b); 1 reference
} public string Phone { get; set; }
conn.Close(); ¥

GridViewZ.DataSource = books;
GridView2.DataBind();

21



ASP.Net core 3.1 Crud Pperation with ADO.Net

» Ref Link

https://tutorialshelper.com/asp-net-core-3-1-
crud-operation-with-ado-net/
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Entity Framework(EF) Core

- |s a new version of Entity Framework after EF 6.x.

- It is open-source, lightweight, extensible and a cross-platform version
of Entity Framework data access technology.

- Entity Framework is an Object/Relational Mapping (O/RM)
framework. It is an enhancement to ADO.NET that gives developers an

automated mechanism for accessing & storing the data in the
database.

- EF Core is intended to be used with .NET Core applications. However,
it can also be used with standard .NET 4.5+ framework based
applications.

23




Application
Type

EF Core

Framework

OS

\-

foplications | | Apnlioations | | Devices +loT,
ppWeb p(lljons ole Mgl():ﬂe, MobileAppliction
API, winForm Xbo;( Al’ldf?l(é, IOS,
Console, WPF, Surface Hub Windos
etc ASP.NET
EF Core EF Core EF Core EF Core
.NET Core .NET 4.56+ UWP Xamarine
Windows,
Mac, Windows Windows 10 Mobile
Linux

figure showing supported application types, .NET Frameworks and OSs.
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EF Core Development Approaches

e EF Core supports two development approaches:
(1) Code-First (2) Database-First.

e EF Core mainly targets the code-first approach and provides some
support for the database-first.

* In the code-first approach, EF Core APl creates the database and
tables using migration based on the conventions and configuration

orovided in your domain classes. This approach is useful in Domain

Driven Design (DDD).

* In the database-first approach, EF Core API creates the domain and

context classes based on your existing database using EF Core

commands. This has limited support in EF Core as it does not support
visual designer or wizard.
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EF Core Development Approaches

Entity

Framework

Database-First Approach

(

.

~N

Context and Entity

Classes

y,

Generate Data Access Classes for Existing Database

[

Domain Classes

\

Tables
N—" ——
~ )

Entity

J

Framework

Code-First Apporach Create

A

Tables

[

>
—

Create Database from the Domain Classes

Database
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EF Corevs EF 6

- Entity Framework Core is the new and improved version of
Entity Framework for .NET Core applications.

- EF Core continues to support the following features and
concepts, same as EF 6.
* DbContext & DbSet
* Data Model
* Querying using Ling-to-Entities
* Change Tracking
* SaveChanges
* Migrations

27



EF Corevs EF 6

- EF Core includes the following new features which are not supported
In EF 6.x:

Easy relationship configuration

Batch INSERT, UPDATE, and DELETE operations
In-memory provider for testing

Support for loC (Inversion of Control)

Unique constraints

Shadow properties

Alternate keys

Global query filter

Field mapping

10 DbContext pooling

11. Better patterns for handling disconnected entity graphs

=

© 00 NOUAWN
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EF Core Database Providers

- EF Core uses a provider model to access many different databases.
- EF Core includes providers as NuGet packages which you need to install.
- Below table lists database providers and NuGet packages for EF Core.

NuGet Package
SQL Server Microsoft.EntityFrameworkCore.SqglServer

MySQL MySqgl.Data.EntityFrameworkCore
PostgreSQL Npgsql.EntityFrameworkCore.PostgreSQL
SQlite Microsoft.EntityFrameworkCore.SQLite

QL Compact EntityFrameworkCore.SqlServerCompact40
In-memory Microsoft.EntityFrameworkCore.InMemory

29


https://www.nuget.org/packages/Microsoft.EntityFrameworkCore.SqlServer
https://www.nuget.org/packages/MySql.Data.EntityFrameworkCore
https://www.nuget.org/packages/Npgsql.EntityFrameworkCore.PostgreSQL
https://www.nuget.org/packages/Microsoft.EntityFrameworkCore.SQLite
https://www.nuget.org/packages/EntityFrameworkCore.SqlServerCompact40
https://www.nuget.org/packages/Microsoft.EntityFrameworkCore.InMemory

EF Core Development Approaches

Code First

POCO Entities

N

l

Core

Entity Framework

Database First

D

Database

N

l

l
C D

Database

.

Entity Framework
Core

l N

POCO Entities
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EF Core Code First Approach

- In the EF Core Code First Approach, first, we need to create our application
domain classes such as Student, Branch, Address, etc. and a special class
that derives from Entity Framework DbContext class.

- Then based on the application domain classes and DBContext class, the EF
Core creates the database and related tables.

r D

Domain Classes
and DBContext —> EF Core —>| pData Base

Class

\_

Code First Approach
\ Creates Databases from the Domain Classess




EF Core Code First Approach

- In the code-first approach, the EF Core creates the database and tables using
migration based on the default conventions and configuration. This approach is
useful in Domain-Driven Design (DDD).

- Good option if you don't know the whole picture of your database as you can
just update your Plain Old Class Object (POCO) entities and let EF sync changes to
the database. In other words, you can easily add or remove features defined in
your class without worrying about syncing your database using Migrations.

- You don't have to worry about your database as EF will handle the creation for
you. In essence, database is just a storage medium with no logic.

- You will have full control over the code. You simply define and create POCO
entities and let EF generate the corresponding Database for you. The downside is
if you change something in your database manually, you will probably lose them
because your code defines the database.

- It's easy to modify and maintain as there will be no auto-generated code.
32




Object Relational Mappers

- Essential parts of an ASP.NET MVC application is the architectural design.
It’s the Model-View-Controller (MVC) pattern. It show us the view of the
application and the business logic within the application.

e Model : designed to manage the business logic.
e \View : view that user can see.
e Controller : manages the interaction between Model and View.

- A one of basic end point of project is the Database. We can prepare the
database following many methods. The thing is, we have to access the DB
from the next layer (Controller). In that point, object relational
mapper(ORM) will come to the battle.
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Object Relational Mappers

- An ORM is an application or system that support in the conversion of data
within a relational database management system (RDBMS) and the object
model that is necessary for use within object-oriented programming.

)

Database (RDBMS) ORM Object Model

Convert—> | g m) Convert—
< - - /
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ADDING EF CORE TO AN APPLICATION

Install Entity Framework Core

- Entity Framework Core can be used with .NET Core or .NET 4.6 based
applications. Here, you will learn to install and use Entity Framework Core
.NET Core applications

- EF Core is not a part of .NET Core and standard .NET framework. It is
available as a NuGet package.

- You need to install NuGet packages for the following two things to use EF
Core in your application:

- 1. EF Core DB provider
- 2. EF Core tools
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ADDING EF CORE TO AN APPLICATION

Install EF Core DB Provider

* EF Core allows us to access databases via the provider model. There are different
EF Core DB providers available for the different databases. These providers are

available as NuGet packages.
» First, install the NuGet package for the provider of database you want to access.
e For, MS SQL Server database,
install Microsoft.EntityFrameworkCore.SqlServer NuGet package.
* To Install DB provider NuGet package:
> Right click on the project in the Solution Explorer in Visual Studio

o select Manage NuGet Packages.. (or select on the menu: Tools -> NuGet Package Manager ->
Manage NuGet Packages For Solution).

o search for Microsoft.EntityFrameworkCore.SqlServer and install
36



ADDING EF CORE TO AN APPLICATION

Install EF Core Tools

* Along with the DB provider package, you also need to install EF tools to
execute EF Core commands. These make it easier to perform several EF
Core-related tasks in your project at design time, such as migrations,
scaffolding, etc.

* EF Tools are available as NuGet packages.
e To Install EF Core Tools:
> Right click on the project in the Solution Explorer in Visual Studio

> select Manage NuGet Packages.. (or select on the menu: Tools -> NuGet Package
Manager -> Manage NuGet Packages For Solution).

> search for Microsoft.EntityFrameworkCore.Tools and install
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Data Models

* Entity Framework needs to have a model (Entity Data Model) to
communicate with the underlying database. It builds a model based on the
shape of your domain classes, the Data Annotations and Fluent API
configurations.

» The EF model includes three parts: conceptual model, storage model, and
mapping between the conceptual and storage models.

* In the code-first approach, EF builds the conceptual model based on your
domain classes (entity classes), the context class and configurations.

* EF Core builds the storage model and mappings based on the provider you
use. EF uses this model for CRUD (Create, Read, Update, Delete) operations
to the underlying database.

38




Data Context

» The DbContext class is an integral part of Entity Framework. An instance
of DbContext represents a session with the database which can be used to query
and save instances of your entities to a database.

» DbContext is a combination of the Unit Of Work and Repository patterns.

* DbContext in EF Core allows us to perform following tasks:
> Manage database connection

(o)

Configure model & relationship

(©)

Querying database

(©)

Saving data to the database

(©)

Configure change tracking

o)

Caching

> Transaction management
39




Create Database From Model Using Entity Framework
Core And ASP.NET Core

public class Weblser

{
1. Add these two NuGet packages Eiz}ﬁ‘”‘”f"“‘-‘e’“m””
to the project: [Da;:a:aSEEener-ated{Data:aSEEener-atEdEp-:iDn.Identity]]
» EntityFrameworkCore.SqlServer public int UserID { get; set; j
[Display(Name = "First Name™)]
* Microsoft.EntityFrameworkCore.Tools [Required]
[Stringlength(25)]
2. In Models Folder Create a Class
- public string FirstMName { get; set; }
with Name as WebUser and add [Required]
) [Stringlength(25), MinLength(3)]
these lines of Codes [Display(Name = "Last Name") ]
public string LastName { get; set; }
[EmailAddress]
public string Email { get; set; H
h
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Create Database From Model Using Entity Framework
Core And ASP.NET Core

3. In Models Folder Create a custom DbContext class named AppDbContext
and write the following code.

using Microsoft.EntityFrameworkCore;
Inamespace WebApplicationCoreS5l1.Models

i
public class AppDbContext : DbContext
{
public AppDbContext(DbContextOptions <AppDbContext» options) : base(options)
{
I
public DbSet<WeblUser> WebUsers { get; set; }
I
I
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Create Database From Model Using Entity Framework
Core And ASP.NET Core

3. Build your project
4. Open the appsettings.json file and Add Database Connection string:

"ConnectionStrings": {

"DBConnectionString”: "Data Source=.; Initial Catalog=DotNetCoreDBS; User Id=sa;
Password =123456"

¥
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Create Database From Model Using Entity Framework
Core And ASP.NET Core

5. open the Startup class and add this code to the ConfigureServices()
method.

public void ConfigureServices(IServiceCollection services)

{

services.AddControllersWithViews();

services.AddDbContext<AppDbContext>(o =>
o.UseSqglServer(Configuration.GetConnectionString("DBConnectionString")));

¥

The above code uses AddDbContext() method to register AppDbContext. Notice that the
database connection string stored in the appsettings.json file is supplied to the
UseSqlServer() method.
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Create Database From Model Using Entity Framework
Core And ASP.NET Core

6. Create Database using EnsureCreated() method

- EF Core model is ready, let's try to create the required database using EnsureCreated()
method. This technique is a code based technique and works great for quick and simple
database creation scenarios. If database is already exists, then no action is taken,

otherwise database is created.

- Add following marked as bold in Configure Method
public void Configure(IApplicationBuilder app, IWebHostEnvironment env, AppDbContext db)

{

db.Database.EnsureCreated();
app.UseStaticFiles();
app.UseRouting();
app.UseAuthorization();
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CRUD Operation Using Entity Framework Core

Create MVC Controller with views, using Entity Framework

- Right-click on the controller folder, select add new item, and then
select controller. Then this dialog will be displayed.

4 |nstalled ‘

b Common MVC Controller with views, using Entity
Framework
by Microsoft

‘E: MVC Controller with read/write actions v1.0.0.0
An MYC controller with actions and Razor

‘ESI I MVC Controller with views, using Entity Framework  views to create, read, update, delete, and list
. entities from an Entity Framework data

context.

‘E: MVC Controller - Empty

Controller

‘E: API Controller - Empty
Id: MvcControllerWithContextScaffolder

‘E: APl Controller with read/write actions

‘E: APl Controller with actions, using Entity Framework

Click here to go enline and find more scaffolding extensions.

Add || Cancel 45




CRUD Operation Using Entity Framework Core

Create MVC Controller with views, using Entity Framework

- Enter for Model Class, Data context class, Controller name as shown

~ Tle VleWS as Shown Add MVC Controller with views, using Entity Framework oy
Model class: WebUser (WebApplicationCore51.Models) -
Data context class: AppDbContext (WebApplicationCore51.Models) -+

Wiews:

Generate views
Reference script libraries

Use a layout page:

~Views/Shared/_Layout.cshtml

(Leave empty if it is set in a Razor _viewstart file)

Controller name: WeblsersContraller

Add Cancel
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CRUD Operation Using Entity Framework Core

* Review your generated code in controller and view pages

 Load your controllerin your browser Create
o https://localhost:44347/WebUsers WebUser
o https://localhost:44347 /WebUsers/Create

» Click on Edit, Details and Delete

First Name

Last Mame

Index

Create New Email

First Name Last Name Email

Admin Lname info@gmail.com  Edit | Details | Delete

Back to List
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Unit 6

State Management on ASP.NET Core Application




STATE MANAGEMENT ON STATELESS HTTP

o HTTP is a stateless protocol. So, HTTP requests are independent messages that don’t retain user
values or app states. We need to take additional steps to manage state between the requests.

o State can be managed in our application using several approaches.

HTTP cookies. May include data stored using server-side app code.

Storage Approach

(0o o] {[-1
Session state HTTP cookies and server-side app code
TempData HTTP cookies or session state
Query strings
Hidden fields
HttpContext

Cache

HTTP query strings
HTTP form fields
Server-side app code

Cache Server-side app code




SERVER-SIDE STRATEGIES: SESSION STATE, TEMPDATA,
USING HTTPCONTEXT

Session State

Session state is an ASP.NET Core mechanism to store user data
user browses the application.

while the

It uses a store maintained by the application to persist data across
requests from a client. We should store critical application data in the
user’s database and we should cache it in a session only as a performance

optimization if required.

ASP.NET Core maintains the session state by providing a coo
client that contains a session ID. The browser sends this coo
application with each request. The application uses the session
the session data.

Kie to the
kKie to the

D to fetch



SESSION STATE

While working with the Session state, we should keep the following things in mind:

A Session cookie is specific to the browser session
When a browser session ends, it deletes the session cookie

If the application receives a cookie for an expired session, it creates a new
session that uses the same session cookie

An Application doesn’t retain empty sessions

The application retains a session for a limited time after the last request. The
app either sets the session timeout or uses the default value of 20 minutes

Session state is ideal for storing user data that are specific to a particular session
but doesn’t require permanent storage across sessions



A Session State Example

* We need to configure the session state before using it in our
application. This can be done in the ConfigureServices() method
in the Startup.cs class:

services.AddSession();

» The order of configuration is important and we should invoke the
UseSession() before invoking UseMVC().

o Let’s create a controller with endpoints to set and read a value
from the session:




public class WelcomeController : Controller {
public IActionResult Index()
{
HttpContext.Session.SetString("Name", "John");
HttpContext.Session.SetInt32("Age", 32);
return View();
}
public IActionResult Get() {
User u = new User()
{
Name = HttpContext.Session.GetString("Name"),
Age = HttpContext.Session.GetInt32("Age").Value
Iy

return View(u);



A Session State Example

The Index() method sets the values into session and Get()

method reads the values from the session and passes them into
the view.

Let’s auto-generate a view to display the model values by right-
clicking on the Get() method and using the “Add View” option.

Now let’s run the application and navigate to /welcome.

This will set the session values.

Now let’s navigate to /welcome/get:



TempData

» TempData property which can be used to store data until it is read.

o TempData is particularly useful when we require the data for more

than a single request. We can access them from controllers and
views.

e TempData is implemented by TempData providers using either
cookies or session state.

o Let’s create a controller with three endpoints. In the First() method,
let's set a value into TempData. Then let’'s try to read it
in Second() and Third() methods:



public class TempDataController : Controller {

public IActionResult First() {
TempData["Userld"] = 101,
return View();

}

public IActionResult Second() {
var userld = TempData["Userld"] ?? null;
return View();

}

public IActionResult Third() {
var userld = TempData["Userld"] ?? null;
return View();




TempData

* Now let’s run the application by placing breakpoints in the
Second() and Third() methods.

* We can see that the TempData is set in the First() request and
when we try to access it in the Second() method, it is available.
But when we try to access it in the Third() method, it is
unavailable as is retains its value only till its read.

* Now let’s move the code to access TempData from the controller
methods to the views.
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Let’s create a view for the Second() action method:
@{
ViewData["Title"] = "Second";

var userld = TempData["Userld"].ToString();

}
<h1>Second</h1>

User Id : @userld
Similarly, let’s create a view for the Third() action method:
@{
ViewData["Title"] = "Third";
var userld= TempData["Userld"].ToString();
}
<h1>Third</h1>
User Id : @userld
Let’s run the application and navigate to /first, /second and /third
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* We can see that TempData is available when we read it for the first time and then it
loses its value. Now, what if we need to persist the value of TempData even after
we read it?

e We have two ways to do that:

> TempData.Keep()/TempData.Keep(string key): This method retains the value corresponding
to the key passed in TempData. If no key is passed, it retains all values in TempData.

o TempData.Peek(string key): This method gets the value of the passed key from TempData
and retains it for the next request.

o Let’s slightly modify our second view with one of these methods:
var userld = TempData["Userld"].ToString();
TempData.Keep();
// OR
var userld = TempData.Peek("Userld").ToString();
 Now let’s run the application and navigate to /first, /second and /third.

* We can see that the TempData value persists in the third page even after its read on

the second page.
12




Using HttpContext

o A HttpContext object holds information about the current HTTP
request. The important point is, whenever we make a new HTTP
request or response then the Httpcontext object is created. Each time
it is created it creates a server current state of a HTTP request and

response.

* It can hold information like: Request, Response, Server, Session, Iltem,
Cache, User's information like authentication and authorization and
much more.

* As the request is created in each HTTP request, it ends too after the
finish of each HTTP request or response.

13




Example to Check request processing time using
HttpContext class

» This example check the uses of the HttpContext class. In the global.aspx page
we know that a BeginRequest() and EndRequest() is executed every time
before any Http request. In those events we will set a value to the context
object and will detect the request processing time.

protected void Application BeginRequest(object sender, EventArgs e) {
HttpContext.Current.Items.Add("Begintime", DateTime.Now.ToLongTimeString());
}
protected void Application EndRequest(object sender, EventArgs e) {
TimeSpan diff = Convert.ToDateTime(DateTime.Now.ToLongTimeString()) -
Convert.ToDateTime(HttpContext.Current.Items["Begintime"].ToString());

14



Example to access current information using
HttpContext class

protected void Page Load(object sender, EventArgs e) {

Response.Write("Request URL"+ HttpContext.Current.Request.Url)
Response.Write("Number of Session variable" +

HttpContext.Current.Session.Count);
Response.Write("current Timestamp" + HttpContext.Current.Timestamp);
Response.Write("Object in Application level " +

HttpContext.Current.Application.Count);
Response.Write("Is Debug Enable in current Mode?" +

HttpContext.Current.IsDebuggingEnabled);
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CACHE CLIENT-SIDE STRATEGIES

e COOKIES,
e QUERY STRINGS,
 HIDDEN FIELDS
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Cookies

Reading Cookie

//read cookie from IHttpContext Accessor
string cookieValueFromContext =
httpContextAccessor.HttpContext.Request.Cookies|["key" ];

//read cookie from Request object

string cookieValueFromReq = Request.Cookies[“key"];

Remove Cookie

Response.Cookies.Delete(key);

17



Cookies

Writing cookie

* |n this example, SetCookie method show how to write cookies.

» CookieOption is available to extend the cookie behavior.

public void SetCookie(string key, string value, int? expireTime)
CookieOptions option = new CookieOptions();
if (expireTime.HasValue)
option.Expires = DateTime.Now.AddMinutes(expireTime.Value);
else
option.Expires = DateTime.Now.AddMilliseconds(10);

Response.Cookies.Append(key, value, option);

18



Query strings

We can pass a limited amount of data from one request to another by adding it to
the query string of the new request. This is useful for capturing the state in a
persistent manner and allows the sharing of links with the embedded state.

public IActionResult GetQueryString(string name, int age) {

User newUser = new User()

{

Name = name,
Age = age
¥

return View(newUser);
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Query strings
* Now let’s invoke this method by passing query string parameters:

o /welcome/getquerystring?name=John&age=31

| GetQueryString - WorkingWithS' X +

< C @& https://localhost:44353/welcome/getquerystring?name=John&age=31

WorkingWithStateManagement Home Privacy

GetQueryString

User
Name John
Age 31

Edit | Back to List

20



Query strings

* We can retrieve both the name and age values from the query string and
display it on the page.

* As URL query strings are public, we should never use query strings for
sensitive data.

* In addition to unintended sharing, including data in query strings will make
our application vulnerable to Cross-Site Request Forgery (CSRF) attacks,
which can trick users into visiting malicious sites while authenticated.
Attackers can then steal user data or take malicious actions on behalf of the
user.

21



Hidden Fields

» We can save data in hidden form fields and send back in the next request.

* Sometimes we require some data to be stored on the client side without
displaying it on the page. Later when the user takes some action, we’ll need
that data to be passed on to the server side. This is a common scenario in
many applications and hidden fields provide a good solution for this.

e Let’s add two methods in our WelcomeController:

22



[HttpGet]
public IActionResult SetHiddenFieldValue() f{
User newUser = new User() {

Id = 101, Name = "John", Age = 31

¥

return View(newUser);
}
[HttpPost]

public IActionResult SetHiddenFieldValue(IFormCollection keyValues) {
var id = keyValues["Id"];

return View();

23



Hidden Fields

* The GET version of theSetHiddenValue() method creates a user object and passes
that into the view.

* We use the POST version of the SetHiddenValue() method to read the value of a
hidden field Id from FormCollection.

* In the View, we can create a hidden field and bind the Id value from Model:
o @Html.HiddenFor(model =>model.Id)

e Then we can use a submit button to submit the form:
o <input type="submit" value="Submit" />

* Now let’s run the application and navigate to /Welcome/SetHiddenFieldValue
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Hidden Fields

| - SetHiddenFieldValue - WorkingV X b

< C @ https://localhost:44353/welcome/sethiddenfieldvalue

WorkingWithStateManagement Home Privacy

SetHiddenFieldValue

User

Name John
Age 3]

' Submit | Edit
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Hidden Fields

* On inspecting the page source, we can see that a hidden field is generated on the page
with the Id as the value: <inputid="1d" name="1d" type="hidden" value="101">

* Now click the submit button after putting a breakpoint in the POST method. We can

retrieve the Id value from the FormCollection
[HttpPost]

e -~ e e __-___ ‘-_.. ~ 4 -~ .'_‘_. | chanoe ",>A ~ s 2o .‘:_.,.-,
_._: f‘“’f“ »4‘ l_r‘“- | { ;.-\ — ed \ een . 2 Ta] - 0 ;1 equests ] (J excepn

public IActlonResult SetHlddenFleldValue(IFormCollectlon keyValues)
{

var id = keyValues["Id"];

return View( ) ; IEPREEERE

* Since the client can potentially tamper with the data, our application must always

revalidate the data stored in hidden fields.
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Discussion Exercise

1. Write about the State Management Strategies.

2. What is Session State? Show with an example to manage session state in
ASP.NET Core.

3. Show the difference between TempData and Using HttpContext with suitable

example.

4. How do you manage to handle state with client side strategies?
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Unit 7

Client-Side Development in ASP.NET Core




COMMON CLIENT-SIDE WEB TECHNOLOGIES

» ASP.NET Core applications are we
on client-side web technologies i

» By separating the content of the

0 applications and they typically rely
ke HTML, CSS, and JavaScript.

nage (the HTML) from its layout and

styling (the CSS), and its behavior (via JavaScript), complex web apps

can leverage the Separation of Concerns principle.

* While HTML and CSS are relatively stable, JavaScript, by means of the

application frameworks and utilities developers work with to build

web-based applications.

 We will discuss on JavaScript, jQuery, Angular SPA, React, Vue.



Javascript

e JavaScriptis a dynamic, interpreted programming language of the web.

o Just like CSS, it's recommended to organize JavaScript into separate files, keeping it separated
as much as possible from the HTML found on individual web pages or application views.

 With Javascript, we can perform following:
o Selecting an HTML element and retrieving and/or updating its value.
o Decision Making, complex calculations, Validate Data, Animate and Add Effects
> Interaction with properties of page object
o React to events
o Querying a Web API for data.
> Sending a command to a Web API (and responding to a callback with its result).

o Performing validation.




Quick Example Review on Javascript

Example
<HTML>
K<TITLE> Displaying Text </TITLE>
<BODY>
<script>
document.write(“<hl> Hello Good Day </H1>”);
document.write(“<H3> Best of Luck. </H3>”);
alert(“Hello”);
</script>
</BODY>
</HTML>




Example2
<script type="text/javascript">
51=12;
$2=28;
sum=sl1+s2;
diff=sl1-s2;
mult=s1*s2;
div=sl/s2;
document.write("<br>Sum: "+sum);
document.write("<br>Difference: "+diff);
document.write("<br>Multiply: "+mult);
document.write("<br>Division: "+div);
</script >




Example3 — JavaScript Array

<script>

var sports = new Array( "Football", "Tennis", "Cycling”);
document.write(sports[0]);

document.write(sports[1]);

document.write(sports[2]);

var count = sports.length;

// loop through array elements
for(i=0; i< count; i++)

{

document.write("<br>Index " + i + " is " + sports[i]);

¥

</script>




Example 4 — JavaScript String

e Used for storing and manipulating text
e Zero or more characters within quotes.

/¥ String : J a v a s c r1i p t
Index : © 1 2 3 4 5 6 7 8 9 */
var myText = "Javascript”;

document.write("<br>" + myText.length);
document.write("<br>" + myText.charAt(4));
myText.indexOf("va"));
myText.substr(0,4));
myText.toUpperCase());
myText.tolLowerCase());

document.write("<br>"
document.write("<br>"
document.write("<br>"
document.write("<br>"

+ + + +




Example 5 — JavaScript Function

<script>

// function defination

function callme() {
alert("Hello there");

}

function f3(nl, n2) {
var sum = nl + n2;
return sum;

}

callme(); // calling a function

callme();

var returned_sum = 3(10, 20);

document.write(returned sum);

document.write(f3(20, 30));

</script>




Example 5 — JavaScript Date

<html>
<body>
<h1l>Demo: Current Date</hl1l>
<p id="p1"></p>
<p id="p2"></p>
<script>
document.getElementById("pl").innerHTML = Date();
var currentDate = new Date();
document.getElementById("p2").innerHTML = currentDate;
</script>
</body>

</html>




Javascript Events

Interaction with HTML page and HTML elements is handled through events.
Events can be page loads, button click, pressing a key, select data in form
controls, focus on control, mouse over and mouse out on any element, etc.

Events are a part of the Document Object Model (DOM) and every HTML
element contains a set of events which can trigger JavaScript Code.
We can categories Javascript events on:
Document Level Events - onload, onunload
Form Level Events - Onsubmit, Onreset,Onchange, onselect, onblur, onfocus
Keyboard Events - Onkeydown, onkeypress, onkeyup

Mouse Events - Onclick, ondblclick, onmouseover, onmouseout
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Events -Example
<html>
<head>
<script>
function callme() {
alert("Hello");
document.write("Hello");
}
</script>
</head>
<body>
<form>
<input type = "button" onclick = "callme()" value = "Click Me">
</form>
</body>
</html>
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Events -Example
<html>
<head>
<script type="text/javascript">
function over() {
alert("Mouse Over");
}
function out() {
alert("Mouse Out");
}
</script>
</head>
<body>
<div onmouseover="over()" onmouseout="out()">
<h2> This is inside the division </h2>
</div>
</body>
</html>
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HTML DOM

* When a web page is loaded, browser creates a Document Object

o)

Model of the page. With the object model, JavaScript can do

following:
modify all the HTML elements and attributes in the
change all the CSS styles in the page
Add remove existing HTML elements and attributes
add new HTML elements and attributes
react to all existing HTML events in the page

create new HTML events in the page

13



The HTML DOM model is constructed as a tree of Objects:

‘ Document I

Root element

<html>
I
Element Element
<head> <Body>
Element Attribute: Element: Element:
<t1tle> uhrefv uau ”hln

Text:
"My header"




* In the DOM, all HTML elements are defined as objects. Below example
changes the content (the innerHTML) of the <p> element with id="demo”
and getElementByld is a method and innerHTML is a property

<body>
<p id="demo"></p>
<script>
document.getElementByld("demo").innerHTML = "Hello World!";
</script>

</body>
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Changing HTML Elements

Change the inner HTML of an element
Change the attribute value of an HTML element
element.style.property = new style Change the style an HTML element

. Method Description

Change the attribute of an HTML element

Finding HTML Elements

S Wemod T oepton

document.getElementByld(id) Find an element by element id
o [o ol g g h =i 3 g L S EEN T E G EL S B Find elements by tag name
G ol iy =i A g L ST EES Eln G G El S B Find elements by class name
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Adding and Deleting Elements

document.createElement(element) Create an HTML element
document.removeChild(element) Remove an HTML element
document.appendChild(element) Add an HTML element
document.replaceChild(new, old) Replace an HTML element

document.write(text) Write into the HTML output stream

17




EXAMPLE
<html>
<head>
<script>
var btn = document.querySelector('button’);
function random(number) {
return Math.floor(Math.random() * (number+l));

}
function changeBgColor() {

var rCol = 'rgb(' + random(255) + ',"' + random(255) + ',' + random(255) + ') ';
document.body.style.backgroundColor = rCol;
}

</script>
</head>
<body>
<button onclick= "changeBgColor()">Change color</button>
</body>
</html>
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Form Validation

 JavaScript provides a way to validate form's data on the client's
computer before sending it to the web server.

* Form validation generally performs two functions.

> Basic Validation — check all the mandatory fields are filled in.

o Data Format Validation — data entered checked for correct form and
value with appropriate logic to test correctness of data.



<html> <head> <title>Form Validation</title>

Name
<script type = "text/javascript"> EMail
<I-- // Form validation code will come here. //--> Zip Code

</script></head> Country || USA

<body> Submit

<form action = "next_page" name = "myForm" onsubmit = "return(validate());">
<table cellspacing = "2" cellpadding = "2" border ="1">
<tr> <td align = "right">Name</td> <td><input type = "text" name = "Name" /></td> </tr>
<tr> <td align = "right">EMail</td> <td><input type = "text" name = "EMail" /></td> </tr>
<tr> <td align = "right">Zip Code</td> <td><input type = "text" name = "Zip" /></td> </tr>
<tr> <td align = "right">Country</td> <td>
<select name = "Country">
<option value = "1">USA</option>
<option value = "2">UK</option>
<option value = "3">Nepal</option>
</select>
</td> </tr>
<tr> <td align = "right"></td> <td><input type = "submit" value = "Submit" /></td> </tr>
</table>
</form> </body> </html|>



<script type = "text/javascript">
function validate() {
if( document.myForm.Name.value =="") {
alert( "Please provide your name!" ); document.myForm.Name.focus() ; return false;
}
if( document.myForm.EMail.value =="" ) {
alert( "Please provide your Email!" ); document.myForm.EMail.focus() ; return false;
}
if( document.myForm.Zip.value =="" | | isNaN( document.myForm.Zip.value ) ||
document.myForm.Zip.value.length 1=5) {
alert( "Please provide a zip in the format #####." ); document.myForm.Zip.focus() ; return false;
}
if( document.myForm.Country.value =="-1" ) {
alert( "Please provide your country!" ); return false;

}

return( true );

}

</script>




jQuery

e jQuery is a fast, small and feature-rich JavaScript library included in a
single .js file.

It provides many built-in functions using which developers can
accomplish various tasks easily and quickly.

» Some of the jQuery important features are:

o DOM Selection: jQuery provides Selectors to retrieve DOM element based on
different criteria like tag name, id, css class name, attribute name, value, nth
child in hierarchy etc.

> DOM Manipulation: You can manipulate DOM elements using various built-in
jQuery functions. For example, adding or removing elements, modifying html

content, css class etc. .



jQuery

» Some of the jQuery important features are:

o

Special Effects: You can apply special effects to DOM elements like show or
hide elements, fade-in or fade-out of visibility, sliding effect, animation etc.

Events: jQuery library includes functions which are equivalent to DOM events
like click, dblclick, mouseenter, mouseleave, blur, keyup, keydown etc. These
functions automatically handle cross-browser issues.

Ajax: jQuery also includes easy to use AJAX functions to load data from servers
without reloading whole page.

Cross-browser support: jQuery library automatically handles cross-browser
issues, so the user does not have to worry about it.
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Advantages of jQuery

Easy to learn: jQuery is easy to learn because it supports same JavaScript
style coding.
Write less do more: jQuery provides a rich set of features that increase

developers' productivity by writing less and readable code.

Excellent APl Documentation: jQuery provides excellent online API
documentation.

Cross-browser support: jQuery provides excellent cross-browser support
without writing extra code.

Unobtrusive: jQuery is unobtrusive which allows separation of concerns by

separating html and jQuery code. y



Getting Started with jQuery

* You can start writing jQuery code on any of the editor like notepad, SublimeText,
Visual Studio. it's time to use jQuery.

* There are several ways to start using jQuery on your web site. You can:
°  Download the jQuery library from jQuery.com
> Include jQuery from a CDN, like Google

 There are two versions of jQuery available for downloading:

o Production version - this is for your live website because it has been minified and
compressed

o Development version - this is for testing and development (uncompressed and
readable code)

e The jQuery library is a single JavaScript file, and you reference it with the HTML
<script> tag (notice that the <script> tag should be inside the <head> section)

25




Getting Started with jQuery

<head>
<script src="jquery-3.5.1.min.js"></script>
</head>

If you don't want to download and host jQuery yourself, you can include it from a CDN (Content
Delivery Network).

<script src="https://ajax.googleapis.com/ajax/libs/jquery/3.5.1/jquery.min.js">
</script>

jQuery Syntax

e The jQuery syntax is used to select HTML elements and perform some action on those
element(s). Basic syntax is: $(selector).action()

e A $sign to define/access jQuery

o A (selector) to "query (or find)" HTML elements

* A jQuery action() to be performed on the element(s) 6



Examples:

S(this).hide() - hides the current element.
S("p").hide() - hides all <p> elements.
S(".test").hide() - hides all elements with class="test".
S("#test").hide() - hides the element with id="test".
The Document Ready Event

All jQuery methods in are inside a document ready event.

S(document).ready(function(){

// jQuery methods go here...
};
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Example: jQuery Element Selector to hide all paragraphs

<html>
<head>
<script src="https://ajax.googleapis.com/ajax/libs/jquery/3.5.1/jquery.min.js"></script>
<script>
$(document).ready(function(){
$("button").click(function(){
$("p").hide();
1)
});

</script>
</head>
<body>
<h2>This is a heading</h2>
<p>This is a paragraph.</p>
<p>This is another paragraph.</p>
<button>Click me to hide paragraphs</button>
</body>
</html>




Example: Using id Selector - with id=test will be hidden on button click
$(document).ready(function(){
$("button”).click(function(){
$("#test").hide();

})s
1)

Example: Using .class Selector with class=test will be hidden on button click
$(document).ready(function(){
$("button”).click(function(){
$(".test").hide();

1)
1)
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More Examples of jQuery Selectors

S(this) Current HTML element
S("p") All <p> elements

S("p.intro") All <p> elements with class="intro"

S(".intro") All elements with class="intro"

S("#intro") The first element with id="intro"

S("ul li:first") The first <li> element of each <ul>

S("[hrefS=".jpg']") All elements with an href attribute that ends with ".jpg"

S RGN EEL B All elements with class="head" inside a <div> element with
id="intro"
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jQuery Events

* An event represents the precise moment when something happens.

* An event can be moving a mouse over an element, selecting a radio button,
clicking on an element, etc

e The term "fires/fired" is often used with events. Example: "The keypress event is
fired, the moment you press a key".

e Here are some common DOM events:

Keyboard Events Document/Window
Events

keypress submit load
keydown change resize

keyup focus scroll
mouseleave blur unload

31



jQuery Syntax for Events

S(selector).click(function) Invokes a function when the selected elements are clicked

S e g Ko LI LT T T d (o] ) B Invokes a function when the selected elements are
double-clicked

S(selector).focus(function) Invokes a function when the selected elements receive the
focus

S A e g B V=7 { (i (sd1e]3 ) Invokes a function when the mouse is over the selected

elements
S G B IE T EH (L1 B Invokes a function when a key is pressed inside the

selected elements
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jQuery Event Methods

Example: jQuery Event Methods
$(document).ready(function(){

$("p").click(function(){
$(this).hide();
1)

$("p").dblclick(function(){
$(this).hide();
1)

$("#id1") .hover(function(){
alert("You hover on idl").

})s

})s
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jQuery Effects

Event Method
S(selector).hide()

(selector).show()

Hide selected elements

Show selected elements

(selector).toggle() Toggle (between hide and show) selected elements
S(selector).slideDown()
S(selector).slideUp()

S(selector).slideToggle()

Slide-down (show) selected elements
Slide-up (hide) selected elements

Toggle slide-up and slide-down of selected elements
(selector).fadeln() Fade in selected elements
(selector).fadeOut() Fade out selected elements

(selector).fadeTo() Fade out selected elements to a given opacity

S(selector).fadeToggle() Toggle between fade in and fade out
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jQuery Effects

EX - Fade Paragraph id1 with 50% opacity when btnFade is clicked
<script>

$("#btnFade").click(function(){

$("#id1").fadeTo("slow", 0.5);
1)

</script>
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LEGACY WEB APPS WITH JQUERY

Although ancient by JavaScript framework standards, jQuery continues to be a
commonly used library for working with HTML/CSS and building applications that make
AJAX calls to web APIs.

However, jQuery operates at the level of the browser document object model (DOM),
and by default offers only an imperative, rather than declarative, model.

For example, imagine that if a textbox's value exceeds 10, an element on the page
should be made visible. In jQuery, this would typically be implemented by writing an
event handler with code that would inspect the textbox's value and set the visibility of
the target element.

This is an imperative, code-based approach. Another framework might instead use
databinding to bind the visibility of the element to the value of the textbox declaratively.

As client-side behaviors grow more complex, data binding approaches frequently result
in simpler solutions with less code and conditional complexity
36



jQuery vs a SPA Framework

Factor jQuery Angular
Abstracts the DOM Yes Yes
AJAX Support Yes Yes
Declarative Data Binding Mo Yes
MWV C-style Routing Mo Yes
Templating Mo Yes
Desp-Link Routing Mo Yes

JQuery ¥s a SPA Framework
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Most of the features jQuery lacks intrinsically can be added with the addition of other
libraries. SPA framework like Angular provides these features in a more integrated
fashion, since it's been designed with all of them in mind from the start.

Also, jQuery is an imperative library, meaning that you need to call jQuery functions in
order to do anything with jQuery. Much of the work and functionality that SPA
frameworks provide can be done declaratively, requiring no actual code to be written.

Data binding is a great example of this. In jQuery, it usually only takes one line of code
to get the value of a DOM element or to set an element's value. However, you have to
write this code anytime you need to change the value of the element, and sometimes
this will occur in multiple functions on a page.

Another common example is element visibility. In jQuery, there might be many different
places where you'd write code to control whether certain elements were visible. In each
of these cases, when using data binding, no code would need to be written. You'd
simply bind the value or visibility of the elements in question to a viewmodel on the
page, and changes to that viewmodel would automatically be reflected in the bound

elements.
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Angular SPAs

* Angular remains one of the world's most popular JavaScript frameworks. The redesigned
Angular continues to be a robust framework for building Single Page Applications.

» Angular applications are built from components. Components combine HTML templates
with special objects and control a portion of the page. A simple component from
Angular's docs is shown here:

import{ Component } from '@angular/core';
@Component ({

selector: 'my-app’',

template: '<hl>Hello {{name}}</h1>"’

1)

export class AppComponent{ name = 'Angular'; }
39



Angular SPAs

Components are defined using the @Component decorator function, which takes
in metadata about the component. The selector property identifies the ID of the
element on the page where this component will be displayed.

The template property is a simple HTML template that includes a placeholder
that corresponds to the component's name property, defined on the last line.

o Import { Component } from '@angular/core’;

By working with components and templates, instead of DOM elements, Angular
apps can operate at a higher level of abstraction and with less overall code than
apps written using just JavaScript (also called "vanilla JS") or with jQuery.

Angular also imposes some order on how you organize your client-side script
files.
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Getting Started with Angular

Angular]S is a client side JavaScript MVC framework to develop a dynamic web
application. AngularJS was originally started as a project in Google but now, it is open
source framework. AngularlS is entirely based on HTML and JavaScript, so there is no
need to learn another syntax or language.

Angular]S changes static HTML to dynamic HTML. It extends the ability of HTML by
adding built-in attributes and components and also provides an ability to create custom
attributes using simple JavaScript.

We need the following tools to setup a development environment for AngularJs:
AngularlS Library — download from angularjs.org
Editor/IDE — notepad++, SublimeText, Visual Studio & others
Web server — IS, Apache, etc

Browser
41



Advantages of AngularlS

* Open source JavaScript MVC framework.

» Supported by Google

* No need to learn another scripting language. It's just pure JavaScript and HTML.
o Supports separation of concerns by using MVC design pattern.

o Built-in attributes (directives) makes HTML dynamic.

o Easy to extend and customize.

» Supports Single Page Application.

e Uses Dependency Injection.

e Easyto Unit test.

o REST friendly.
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See this example with jQuery

<IDOCTYPE html>
<html>
<head>
<script src="~/Scripts/jquery-1.10.2.min.js"></script>
</head>
<body>
Enter Your Name: <input type="text" id="txtName" /> <br />
Hello <label id="1blName"></label>

<script>
$(document).ready( function () {
$('#txtName') .keyup(function () {
$('#1blName"') .text($( '#txtName"').val());
1
1)

</script>
</body>
</html>
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Example
» Conversion of above jQuery program to Angular Code to shows plain HTML code with
couple of Angular]S directives (attributes) such as ng-app, ng-model, and ng-bind.

<!DOCTYPE html>

<html>

<head>
<script src="~/Scripts/angular.js"></script>

</head>

<body ng-app>
Enter Your Name: <input type="text" ng-model="name" /> <br />
Hello <label ng-bind="name"></label>

</body>

</html>
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Setup angularjs application in Visual Studio 2019

e Open visual studio create angularjs project name like “angularJsApp”

New Project ? X
1 P Recent = Sort by: Default | & EE] Search (Ctri+§ R~
4 |nstall = :
rialed @ ASP.NET Core Web Application Visual C# Type: Visual C#
4 Visual C# Project templates for creating ASP.NET
Get Started @ ASP.NET Web Application (.NET Framework) Visual C# applications. You can create ASP'NET Web
. Forms, MVC, or Web API applications and
Windows Desktop OO PRI MVCE AR i s add many other features in ASP.NET.
4 Web 7 _l endo . pplication isual (4
Previous Versions F( 4 . ) :
.| Telerik ASP.NET MVC Application Visual C#
NET Core
e Siencten: ° Angular Basic Visual C#
Cloud
Test
WCF |

[N ‘-

Not finding what you are looking for?

Open Visual Studio Installer

Name: i‘AngulersApp{

Location: C:\Users\Administrator\source\repos v Browse...

Solution: Create new solution -

Solution name: AngularJsApp Create directory for solution
Framework: NET Framework 4.6.1  ~ D Create new Git repository

OK ’ Cancel




Setup angularjs application in Visual Studio 2019

o Select an empty project and then click on ok button

? X

New ASP.NET Web Application - AngularJsApp

An empty project template for creating ASP.NET
applications. This template does not have any content in

Fd FI Fl it.
u)_] {.)J (.)—I
Learn more
MVC Web API Single Page
Application r
Azure APl App
| £
"
Add folders and core references for: Authentication: No Authentication
[ ] webForms []MvC [ ] web AP Change Authentication

[C] Enable Docker Compose support (Requires Docker for Windows)

[] Add unit tests

Test project name: AngularlsApp.Tests

\

QK Cancel




Setup angularjs application in Visual Studio 2019

» Right-click on your project select Manage NuGet packages

Build
Rebuild
Clean
View
Analyze
Publish...

Overview

Scope to This

New Solution Explorer View
Add

Quick Install Package...
Manage NuGet Packages...

Manage Client-Side Libraries...

Set as StartUp Project
Debug

Solution Explorer v

Shift+Alt+0

’

- o-sSs¢gal@ K-

h Explorer (Ctrl+

;)
AngularJsApp' (1 project)

larJsApp
nnected Services
Operties

ferences
ckages.config

eb.config

= X

ol
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Setup angularjs application in Visual Studio 2019

* Browse the angularjs.core and install

NuGet: AngularisApp + X EEUIANETEETTY

Browse  Installed  Updatesfl] NuGet Package Manager: AngularJsApp
angular js X - o Include prerelease Package source:  All - 03
o pﬂ(iﬂg(‘ﬁ found Show 2 more results  Dismiss A

g AngularJS.Core

A AngularJS.Core by The Angular)S Tearmn, 3.93M downloads

AngularJS. HTML enhanced for web apps!

Version: Latest stable 1.7.8 - Install
a Angu"”&R"utG by The Angular)S Team, 1.66M downloads vil8
Angular)S. HTML enhanced for web apps! | v ) Options
AngularJS.Animate by The Angular)s Team, 1.34M downloads vi.78 Description
Angular)S. HTML enhanced for web apps! See the AngularJS.* packages for other Angular modules
Version: 1.78
AngularJ)S.Sanitize by The Angular)S Team, 1.05M downloads vi.7g Author(s): The Angular)S Team

Angular)S, HTML enhanced for web apps!
Date published: Tuesday, April 16, 2019 (4/16/2019)

e & € @

- j 3 httpy//angularjs.or
Anguh'.u'-sootstr‘p by AngularUl Team, 2.58M downloads v25.0 Pro,ect URL: th ngula |
Native Angular)S (Angular) directives for Bootstrap. Small footprint (5k8 gzipped!), no 3rd party JS dependencies (jQu... Report Abuse:  hitps://www.nuget.org/packages/
AngulalS. Core/1.7.8/ReportAbuse
Tags: angularjs, angular
AngularJS.Resource by The AngularS Team, 774K downloads vi7g




Setup angularjs application in Visual Studio 2019

* Once installed the angularjs you will have js file in a script folder

] Solution ‘Angular)sApp’ (1 project)
4 AngulaszApp
&P Connected Services
b M Properties
P =B References
4 Scripts
ﬂ LT angular-mocks.js
LT angular,js
LT angular.min,js
B angular.minjs.map
¢ packages.config
b ¢ Web.config
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Setup angularjs application in Visual Studio 2019

* Setup is done. Now let’s test by using one sample example. Create a
directory structure for angularls application following the below image.

. Solution 'AngularJsApp’ (1 project)
4 7] AngularJsApp
&P Connected Services
> M Properties

P =B References

4 & controllers
LT Appjs
LT TestControllerjs
p Scripts
¢ packages.config

/7 I3 testhtml
b ¢ Web.config
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App.Js var app = angular.module('myapp', []1);

.. app.controller(’TestController’, function ($scope
TestController.js ( ($scope) {

rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr

Test.html b;

<IDOCTYPE html>
<html>
<head>»
<meta charset="utf-38" />
<title»</title>
<script src="5Scripts/angular.js"»</script>
<script src="Controllers/App.js"»</script>
<script src="Controllers/TestController.js"»</script>
< /head>
<body ng-app="myapp”>»
<div ng-controller="TestController”>»
<h2»{{testmessage}}</h2>
<fdiv>
</body>
</html>|
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REACT

» Unlike Angular, which offers a full Model-View-Controller pattern implementation, React
is only concerned with views. It's not a framework, just a library. There are a number of
libraries that are designed to be used with React to produce rich single page

applications.

* One of React's most important features is its use of a virtual DOM. The virtual DOM
provides React with several advantages, including performance (the virtual DOM can
optimize which parts of the actual DOM need to be updated) and testability (no need to
have a browser to test React and its interactions with its virtual DOM).

o Rather than having a strict separation between code and markup (with references to
JavaScript appearing in HTML attributes perhaps), React adds HTML directly within its
JavaScript code as JSX. JSX is HTML-like syntax that can compile down to pure JavaScript.
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REACT

* For Example

<ul>
{ authors.map(author =>
<1li key={author.id}>{author.name}</1i>

)}

</ul>

» Because React isn't a full framework, you'll typically want other libraries to handle things
like routing, web API calls, and dependency management. The nice thing is, you can pick
the best library for each of these.

53




Create a Node.js and React app in Visual Studio

Prerequisites
e Visual Studio installed and the Node.js development workload.

* |If you need to install the workload but already have Visual Studio, go to Tools >
Get Tools and Features..., which opens the Visual Studio Installer. Choose the

Node.js development workload, then choose Modify.
Web & Cloud (7)

@ ASP.NET and web development an Azure development
Build web applications using ASP.NET, ASP.NET Core, a Azure SDK, tools, and projects for developing cloud apps
HTML, JavaScript, and container development tools. and creating resources.
# Python development Node.js development
Editing, debugging, interactive development and source Build scalable network applications using Node,s, an
control for Python. asynchronous event-driven JavaScript runtime.
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Create a Node.js and React app in Visual Studio

Create a Node.js Web Application Project
1. Open Visual Studio.
2. Create a new project.

» Press Esc to close the start window. Type Ctrl + Q to open the search box, type Node.js,
then choose Blank Node.js Web Application - JavaScript

* Inthe dialog box that appears, choose Create.

* |f you don't see the Blank Node.js Web Application project template, you must add the
Node.js development workload.

* Visual Studio creates the new solution and opens your project.
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Create a Node.js and React app in Visual Studio

Add I Solution Explorer v+ 4§ X
This app requires a number of npm modules | scaich soiution Explorer (cul+) P -
2

b Solution ‘NodejsWebAppBlank' (1 project)
4 NodejsWebAppBlank [

to run correctly.

e react b *Enpm 3
£J package,json 4
» react-dom B READMEmd
[N server.js 5
* express
» path

o ts-loader

Solution Explorer REET NI,

« typescript
» webpack

« webpack-cli
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Create a Node.js and React app in Visual Studio

Add npm packages

1. In Solution Explorer (right pane), right-click the npm node in the project and
choose Install New npm Packages. In the Install New npm Packages dialog box,
you can choose to install the most current package version or specify a version.

2. In the Install New npm Packages dialog box, search for the react package, and

select Install Package to install it.

Install Mew npm Packages .
foact »  reactisso
react 16.6.0 bact
React is a JavaScript library for building user... Description: React is a JavaScript library for building user interfaces.
: Homepage: https://react|s.org/
cmmet mmdeen €4 A0 I 57




Create a Node.js and React app in Visual Studio

When installed, the package appears under the npm node. JSON

"dependencies": {

 The project's package.json file is updated with the
"express": "~4.17.1",

new package information including the package version. "path’: "~0.12.7",

e Instead of using the Ul to search for and add the 'react": "~16.13.1",

rest of the packages one at a time, paste the ‘react-dom™ "~16.13.1%,

"ts-loader": "~7.0.1",

following code into package.json.
"typescript": "~3.8.3",

To do this, add a dependencies section with this code: webpack”: "~4.42.1",

"webpack-cli": "~3.3.11"



CHOOSING A SPA FRAMEWORK

o When considering which JavaScript framework will work best to support your SPA, keep in
mind the following considerations:

> |s your team familiar with the framework and its dependencies (including TypeScript in some
cases)?

> How opinionated is the framework, and do you agree with its default way of doing things?
> Does it (or a companion library) include all of the features your app requires?

> s it well documented?

> How active is its community? Are new projects being built with it?

o How active is its core team? Are issues being resolved and new versions shipped regularly?

e JavaScript frameworks continue to evolve with breakneck speed. Use the considerations listed
above to help mitigate the risk of choosing a framework you'll later regret being dependent
upon
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Discussion Exercise

1. Write about the State Management Strategies.

2. What is Session State? Show with an example to manage session state in
ASP.NET Core.

3. Show the difference between TempData and Using HttpContext with suitable

example.

4. How do you manage to handle state with client side strategies?
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BASIC CONCEPTS ON ASP.NET CORE SECURITY




BASIC CONCEPTS ON ASP.NET CORE SECURITY

* This Unit shows how to add users to an ASP.NET Core application by
adding authentication. With authentication, users can register and log in
to your app using an email and password. Whenever you add
authentication to an app, you inevitably find you want to be able to
restrict what some users can do. The process of determining whether a
user can perform a given action on your app is called authorization.

* The two concepts are often used together, but they’re definitely distinct:
a. Authentication—The process of determining who made a request

b. Authorization—The process of determining whether the requested action
is allowed




Authorization in ASP.NET Core

e The ASP.NET Core framework has authorization built in, so you can use it anywhere in your
app, but it’'s most common to apply authorization as part of MVC. For both traditional web
apps and web APIs, users execute actions on your controllers. Authorization occurs before
these actions execute, as shown in figure 1. This lets you use different authorization
requirements for different action methods. As you can see in figure, authorization occurs
as part of MvcMiddleware, after AuthenticationMiddewarehas authenticated the request.

e Authorization, is checking whether a particular user has permission to execute an action.
In ASP.NET Core, you’d achieve this by checking whether a user has a particular claim.

e A request is made to the URL /recipe/index. MvcMiddlewareThe authentication
middleware deserializes the ClaimsPrincipal from the encrypted cookie. The authorize
filter runs after routing but before model binding or validation. If authorization is
successful, the action method executes and generates a response as normal. If
authorization fails, the authorize filter returns an error to the user, and the action is not
executed.




A request is made Static file
to the URL /receipe/index middleware
(o8
The authentication middlware o
deseralizes the Claims Principal Authentication
from the encrypted cookie. middleware

&y

............................................................................................

The authorize filter runs :
after routing but before Authorize filter
model binding or validation. :

A If authorization is fails,
: : the authorize filter returns an
i error to the user, and the action

C . i is not executed.
If authorization is successful, !

the action method exeuctes Index
and generates a response action method
as normal. : A
Index view
MvcMiddleware




Authorization in ASP.NET Core

There’s an even more basic level of authorization that you haven’t
considered yet— only allowing authenticated users to execute an
action. There are only two possibilities:

The user is authenticated- The action executes as normal.
The user is unauthenticated - The user can’t execute the action.

You can achieve this basic level of authorization by using the [Authorize]
attribute. You can apply this attribute to your actions, to restrict them to
authenticated (logged-in) users only. If an unauthenticated user tries to
execute an action protected with the [Authorize] attribute in this way,
they’ll be redirected to the login page.



Authorization in ASP.NET Core

public class HomeController : Controller

i

public IActionResult Index &

{

Applies [Autharize] to
individual actions orwhaole
cantrallers

return Yiew () ;

[Authorize

public IActionResult AuthedUseronly ()
i

return Yiew () ;

This actioncan he

executed by anyone, even

This action can only he
execUted by authenticated
USers.



ASP.NET Core Identity

ASP.NET Core Identity adds user interface (Ul) login functionality to ASP.NET Core
web apps and manages users, passwords, profile data, roles, claims, tokens, email
confirmation, and more.

Users can create an account with the login information stored in Identity

Create a Web app with authentication

o

o

Create an ASP.NET Core Web Application project with Individual User Accounts.
In Visual Studio, Select File > New > Project.

Select ASP.NET Core Web Application. Name the project WebApp1 to have the
same namespace as the project download. Click OK.

Select an ASP.NET Core Web Application, then select Change Authentication.
Select Individual User Accounts and click OK.



ASP.NET Core Identity

* The generated project provides ASP.NET Core Identity as a Razor Class
Library. The Identity Razor Class Library exposes endpoints with

the lIdentity area.
e For example:
> [ldentity/Account/Login
> [ldentity/Account/Logout
o [ldentity/Account/Manage
Apply migrations
* Apply the migrations to initialize the database and Run the following
command in the Package Manager Console (PMC):

* PM> Update-Database




ASP.NET Core ldentity

Test Register and Login

* Run the app and register a user.
Depending on your screen size, you might
need to select the navigation toggle button
to see the Register andLogin links.

View the Identity database

e From the View menu, select

e SQL Server Object Explorer

Navigate to (localdb)MSSQLLocalDB

(SQL Server 13). Right-click on
dbo.AspNetUsers > View Data:

S5CL Server Object Explorer
("
4 ¥ SOL Server

= (localdb)\MSSCLLocalDE (SOL Server 13.0.1601 - |
-

|

B

|

Databases

Systern Databases
4 g aspnet-WebApp1

P
P
>
P
P
>
P
P

Tables
Systermn Tables
External Tables

BEH dbo._ EFMigrationsHistory

BEH dbo.AspMetRoleClaims

EH dbo.AspMetRoles

BEH dbo.AspMetUserClaims

EH dbo.AspMetUserLogins
EH dbo.AspMetUserRoles

b [z=z] dbo.AspMNetUsers

>

f

R = = A

YO OX 4

5
5
= (loca

Projects

&

ol O

Data Comparison...
Script As
View Code

View Designer
View Permissions
View Data

Delete

Rename

Refresh
Properties

Crel

3

EDH




ADDING AUTHENTICATION TO APPS AND IDENTITY
SERVICE CONFIGURATIONS

» Services are added in ConfigureServices.

 The typical pattern is to call all the Add{Service} methods, and
then call all the services.Configure{Service} methods.

public void ConfigureServices(IServiceCollection services)
{
services.AddDbContext<ApplicationDbContext>(options =>
// options.UseSqglite(
options.UseSqglServer(
Configuration.GetConnectionString("DefaultConnection")));
services.AddDefaultIdentity<IdentityUser>(
options=>options.SignIn.RequireConfirmedAccount = true)

.AddEntityFrameworkStores<ApplicationDbContext>();
10



services.AddRazorPages();

services.Configure<IdentityOptions>(options =>

{

// Password settings.

options.

options.

options

options.

options.

options

options

options

options.

Password.RequireDigit = true;

Password.RequireLowercase = true;

.Password.RequireNonAlphanumeric = true;

Password.RequireUppercase = true;

Password.RequiredLength = 6;

.Password.RequiredUniqueChars = 1;

// Lockout settings.

.Lockout.DefaultLockoutTimeSpan = TimeSpan.FromMinutes(5);

.Lockout.MaxFailedAccessAttempts = 5;

Lockout.AllowedForNewUsers = true;
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// User settings.
options.User.AllowedUserNameCharacters =
"abcdefghijklmnopqgrstuvwxyzABCDEFGHIJKLMNOPQRSTUVWXYZ0123456789-. @+";
options.User.RequireUniqueEmail = false;

})s

services.ConfigureApplicationCookie(options =>

{

// Cookie settings

options.Cookie.HttpOnly = true;
options.ExpireTimeSpan = TimeSpan.FromMinutes(5);
options.LoginPath = "/Identity/Account/Login";
options.AccessDeniedPath = "/Identity/Account/AccessDenied";
options.SlidingExpiration = true;

})s
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The preceding highlighted code configures Identity with default
option values. Services are made available to the app
through dependency injection.

The template-generated app doesn't use authorization.

app.UseAuthorization is included to ensure it's added in the
correct order should the app add authorization.

UseRouting, UseAuthentication, UseAuthorization,
and UseEndpoints must be called in the order shown in the
preceding code.
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public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
if (env.IsDevelopment()) {
app.UseDeveloperExceptionPage();
app.UseDatabaseErrorPage();
}
else {
app.UseExceptionHandler("/Error");
app.UseHsts();
}
app.UseHttpsRedirection();
app.UseStaticFiles();
app.UseRouting();
app.UseAuthentication();
app.UseAuthorization();
app.UseEndpoints(endpoints =>

{

endpoints.MapRazorPages();

})s
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AUTHORIZATION: ROLES, CLAIMS AND POLICIES,
SECURING CONTROLLERS AND ACTION METHODS

* When an identity is created it may belong to one or more roles. For example,
Adminl may belong to the Administrator and User roles whilst Userl may only
belong to the User role. How these roles are created and managed depends on
the backing store of the authorization process. Roles are exposed to the
developer through the IsInRole method on the ClaimsPrincipal class.

Roles

* Role-based authorization checks are declarative—the developer embeds them
within their code, against a controller or an action within a controller, specifying
roles which the current user must be a member of to access the requested
resource.
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Roles

» For example, the following code limits access to any actions on the
AdministrationController to users who are a member of

the Administrator role:
[Authorize(Roles = "Administrator")]
public class AdministrationController : Controller{}

* You can specify multiple roles as a comma separated list:
[Authorize(Roles = "HRManager,Finance")]
public class Salary Controller : Controller {}

 This controller would be only accessible by users who are members of
the HRManager role or the Finance role.
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Roles

e If you apply multiple attributes then an accessing user must be a
member of all the roles specified; the following sample requires
that a user must be a member of both the PowerUser and

ControlPanelUser role.
[Authorize(Roles = "PowerUser")]

[Authorize(Roles = "ControlPanelUser")]

public class ControlPanelController : Controller

{
}
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Roles

- You can further limit access by applying additional role authorization
attributes at the action level:

[Authorize(Roles = "Administrator, PowerUser")]
public class ControlPanelController : Controller {
public ActionResult SetTime()

1
}

[Authorize(Roles = "Administrator")]
Public ActionResult ShutDown()

{
}

18




Policy based Role Checks

» Role requirements can also be expressed using the new Policy syntax,
where a developer registers a policy at startup as part of the Authorization
service configuration. This normally occurs in ConfigureServices() in

your Startup.cs file.

public voild ConfigureServices (IServiceCollection services)

{

services.AddControllersWwithViews () ;

services.AddRazorPages () ;
services.AddAuthorization (options =>

{
options.AddPolicy ("RequireAdministratorRole",

policy =>policy.RequireRole ("Administrator™));
H)i

19



Policy based Role Checks

Policies are applied using the Policy property on the AuthorizeAttribute
attribute:
[Authorize(Policy = "RequireAdministratorRole")]
public IActionResult Shutdown() {
return View();

}

If you want to specify multiple allowed roles in a requirement then you can
specify them as parameters to the RequireRole method:
options.AddPolicy("ElevatedRights", policy =>

policy.RequireRole("Administrator"”, "PowerUser", "BackupAdministrator"));

This example authorizes users who belong to the Administrator, PowerUser or
BackupAdministrator roles.
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Add Role services to Identity

» Append AddRoles to add Role services:

public void ConfigureServices(IServiceCollection services)
{
services.AddDbContext<ApplicationDbContext>(options =>
options.UseSglServer(
Configuration.GetConnectionString("DefaultConnection")));
services.AddDefaultIdentity<IdentityUser>().AddRoles<IdentityRole>()
.AddEntityFrameworkStores<ApplicationDbContext>();
services.AddControllersWithViews();

services.AddRazorPages();
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Claims and Policies

* When an identity is created it may be assigned one or more claims
issued by a trusted party. A claim is a name value pair that represents
what the subject is, not what the subject can do. Claims based
authorization, at its simplest, checks the value of a claim and allows
access to a resource based upon that value.

* For example, if you want access to a night club the authorization
process might be: The door security officer would evaluate the value
of your date of birth claim and whether they trust the issuer (the
driving license authority) before granting you access.

* An identity can contain multiple claims with multiple values and can
contain multiple claims of the same type.
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Adding claims checks

» First you need to build and register the policy. This takes place as part of the
Authorization service configuration, which normally takes part in
ConfigureServices() in your Startup.cs file.

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();
services.AddRazorPages();

services.AddAuthorization(options =>

{

options.AddPolicy("EmployeeOnly", policy =>
policy.RequireClaim("EmployeeNumber"));

1)
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Adding claims checks

* In this case the EmployeeOnly policy checks for the presence of an EmployeeNumber
claim on the current identity. You then apply the policy using the Policy property on the
AuthorizeAttribute attribute to specify the policy name;

[Authorize(Policy = "EmployeeOnly")]

public IActionResult VacationBalance() { return View(); }

» The AuthorizeAttribute attribute can be applied to an entire controller, in this instance
only identities matching the policy will be allowed access to any Action on the
controller.

[Authorize(Policy = "EmployeeOnly")]

public class VacationController:Controller {

public ActionResult VacationBalance() { }
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Policies

* If you apply multiple policies to a controller or action, then all policies must pass before

access is granted. For example:
[Authorize(Policy = "EmployeeOnly")]
public class SalaryController : Controller{

public ActionResult Payslip()

{
}

[Authorize(Policy = "HumanResources")]

public ~ ActionResult UpdateSalary()

{
}
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Policy-based authorization in ASP.NET Core

e Underneath the covers, role-based authorization and claims-basedauthorization use a
requirement, a requirement handler, and a pre-configured policy.

* An authorization policy consists of one or more requirements. It's registered as part of the
authorization service configuration, in the Startup.ConfigureServices method:

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();
services.AddRazorPages();
services.AddAuthorization(options =>

{
options.AddPolicy("AtLeast21", policy =>

policy.Requirements.Add(new MinimumAgeRequirement(21)));

1;
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Apply policies to MVC controllers

 If you're using Razor Pages, see Apply policies to Razor Pages in this

document.

* Policies are applied to controllers by using the [Authorize] attribute with

the policy name. For example:
using Microsoft.AspNetCore.Authorization;
Using Microsoft.AspNetCore.Mvc;

[Authorize(Policy = "AtLeast21")]

public class AlcoholPurchaseController : Controller {

public IActionResult Index() => View();
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Apply policies to Razor Pages

» Policies are applied to Razor Pages by using the [Authorize] attribute with
the policy name. For example:
using Microsoft.AspNetCore.Authorization;
using Microsoft.AspNetCore.Mvc.RazorPages;
[Authorize(Policy = "AtLeast21")]
public class AlcoholPurchaseModel : PageModel

{
}

* Policies cannot be applied at the Razor Page handler level, they must be
applied to the Page.Policies can be applied to Razor Pages by using an

authorization convention.
28



Securing Action Method in Controller

Let’s assume that the About page is a secure page and only authenticated
users should be able to access it. We just have to decorate the About
action method in the Home controller with an[Authorize] attribute:

[Authorize]
public IActionResult About() {

ViewData["Message"] = "This is my about page";

return View();

}

Making the preceding change will redirect user to the log-in page when
user tries to access the log-in page without logging in to the application:
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Securing Action Method in Controller

* Making the preceding change will redirect the user to the log-in page
when the user tries to access the log-in page without logging in to the

a p p I icatio n . C' | [} localhost:63705/Account/Login?ReturnUrl=%2FHome%2FAbout
[ ]
ASP.Net 5 Security Home Contact

Log in.

Use a local account to log in.

Email

Password

Remember me?
Login

Register as a new user?

30
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HOSTING AND DEPLOYING ASP.NET CORE APPLICATION

* Once you successfully developed your web application, you may require to host the
application to the server so that other people can access it. The process of
deploying/installing an application into the server is called "Hosting".

Web Server

* A web server is a process for hosting web applications, which responds to HTTP
requests and delivers contents and services. A web server allows an application to
process messages that arrive through specific TCP ports (by default). Default port for
HTTP trafficis 80, and the one for HTTPS is 443.

* When you visit a website in your browser, you don’t typically specify the port number
unless the web server is configured to receive traffic on ports other than the default.

e Some of the web servers that we can use to host ASP.NET Core are: Microsoft IIS,
Apache, NGINX.
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IS web server

* The IS web server comes from the Microsoft stable and runs only on the
Microsoft Windows operating system. It is actually not free, since it comes as
a part of the Windows operating system. You might feel comfortable with IIS
if you have already used the Windows OS ecosystem. It also comes with the
support of the .NET framework which was released by Microsoft and support
services for IS are provided directly by Microsoft.

Advantages of IIS
e Has the support of Microsoft.
* You can have access to the .NET framework along with ASPX scripts.

e Can be easily integrated with other Microsoft services like ASP, MS SQL etc.




Apache web server

» Apache is an open source web server which was developed and maintained Apache
Software Foundation. It is a result of the collaborative efforts which was aimed at

creating a robust and secure commercial grade web server which adhered to all the
HTTP standards.

e |t has been the market leader since it entered the web server market in 1995 and
remains the web server of choice for its ability to function across multiple platforms.

 Apache is equally efficient on almost every operating system but finds can be found to
be in maximum use when combined with Linux.
Advantages of Apache
°  As it open source, so there are no licensing fees.
o |tis flexible, meaning that you can choose the modules you want.
o Has a high level of security.
o Strong user community to provide backend support.
o Runs equally well on UNIX, Linux, MacQOS, Windows.




NGINX

NGINX is a robust web server which was developed by Russian developer Igor Sysoeuv. It
is a free open-source HTTP server which can be used as a mail proxy, reverse proxy
server when required. Most importantly, it can take care of a huge number of
concurrent users with minimal resources in an efficient manner. NGINX, is particularly
of great help when the situation of handling massive web traffic arises.

NGINX has a lightweight architecture and is highly efficient. This is probably the only
web server which can handle huge traffic with very limited hardware resources. NGINX
acts as a sort of shock absorber which protects Apache servers when faced with
security vulnerabilities and sudden traffic spikes.

Advantages of NGINX

o

o

(©)

Open source.
A high speed web server which can be used as a reverse-proxy server.
Can be used better in a virtual private server environment.



HOSTING MODELS IN ASP.NET CORE

* There are 2 types of hosting models in ASP.NET Core:
o Qut-of-process Hosting
o In-process Hosting

o Before ASP.Net Core 2.2 we have only one hosting model, which is Out-of-process
but after due to the performance we have In Process Hosting Model in 2.2+

versions.
Out-of-process Hosting Model

* In Out-of-process hosting models, we can either use the Kestrel server directly as a
user request facing server or we can deploy the app into IIS which will act as a
proxy server and sends requests to the internal Kestrel server. In this type of
hosting model, we have two options:

o Using Kestrel
o Using Proxy Server




Out-of-process Hosting Model

Using Kestrel

o Kestrel is a cross-platform web server for ASP.NET Core. Kestrel is the webserver that's
included by default in ASP.NET Core project templates.

o Kestrel itself acts as edge server which directly server user requests. It means that we
can only use the Kestrel server for our application.

Kestrel

Http
< > ASP.NET Core Application




Out-of-process Hosting Model

Using a Proxy Server

* Due to limitations of the Kestrel server, we cannot use this in all the apps. In such cases,
we have to use powerful servers like IIS, NGINX or Apache. So, in that case, this server
acts as a reserve proxy server which redirects every request to the internal Kestrel sever
where our app is running. Here, two servers are running. One is IIS and another is
Kestrel.

» This model is a default model for all the applications implemented before .NET Core 2.2.
But there are some of the limitations of using this type such as performance slowness.

IIS ASP.NET Core Application

‘ ASP.NET C Modul \ ‘ \: > .« es \
@ Http ore Module Http Kestrel C(I;Ir:::gxt Application Code

A
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In-process Hosting Model

After the release of .NET Core 2.2, it introduced a new type of hosting which is called
In-process hosting. In this type, only one server is used for hosting like IS, Nginx or
Linux. It means that the App is directly hosted inside of 1IS. No Kestrel server is being
used. IIS HTTP Server (lISHttpServer) is used instead of the Kestrel server to host apps
in IS directly. ASP.NET Core 3.1 onwards In-process hosting model is used as a default
model whenever you create a new application using an existing template.

IIS

IISHttpServer

< HTTP >
‘ Application I




Let’s see different types of hosting models

* Now let's see how to check which hosting model is being used.

* Run the application on the IISExpress server, then open the browsers network tab and
check for the first call. Under the server section, you will able to see it showing
Microsoft IIS.

Console

lw (] Elements L onso SOUTCES Mebwork Performance Memaory Apphication Securty
® & ¥V O Preserve log Disable cache = Online ¥ +
W ms &0 g 30 g &0 g £0 g & g
Jarme X Headers Preview  Response  Timing
I — Remote Address: [::1]:61738

Referrer Policy: no-referrer-when-downgrade

¥ Response Headers
Content-Length: 528
Lontent-Type: application/]son; charset=utf-8

Date: Thu, 23 Jan 2028 12:33:32 GMT

Server: Microsoft-IIS/16.8

X-Powered-By: ASP.NET 10




Let’s see different types of hosting models

o Stop the app and open the command prompt and run the same application using
dotnet CLI using the command dotnet run. Now it will host app on
http://localhost:5000.

b Administrator: Windows PowerShell - dotnet run -

_HDutHetEuPEprIdutnet run

: nicrosort.Hosting. Lifetime A1
Mow listening on: |http:/7localhost :5880
Microsoft.Hosting.Litetime W]
Application started. Press Ctrl+C to shut down.

Microsoft.Hosting.Lifetime[B]
Hozting environment: Development
Microsoft.Hosting.Lifetime[B]

Content root path:
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Let’s see different types of hosting models

* Browse the URL and open the network tab to see the server attribute as Kestrel.

[w ﬂ Elements Console Sources Network Performance Memory Application

® © V¥ Q WM Preservelog [ Disablecache  Online ¥  # ¥

Filtel Clear Hide data URLs E8 | XHR JS CSS Img Media Font Doc WS M
| 200 ms 400 ms 600 ms 200 ms 1000 ms

=

Name X Headers Preview Response Initiator Timing
__| localhost

content-type: text/html; charset=utf-8
bootstrap.min.css

o date: Sun, @6 Dec 2020 16:86:89 GMT
site.css

. o server: Kestrel
jguery.min.js -

o status: 280

7 reauests 1.8 kB transferred 129 kBT
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DEPLOY .NET CORE APPLICATION ON LINUX

» When Microsoft launched their .Net Core framework the key selling point was it is a
cross-platform framework, which means that now we can host our .Net application not
only on Windows but on Linux too.

» Let’s see how we can deploy .Net core application on Linux.
Step 1 - Publish your .Net Core application

o First, create a .Net core application on VS; you can make an MVC project or Web API
project and if you already have an existing project, then open it.

Right Click on your project
Click on publish

Now create a new publish profile, and browse the folder where you want to publish
your project dll

Click on publish so it will create your dll in the folder
13




DEPLOY .NET CORE APPLICATION ON LINUX

Step 2 - Install required .Net Module on Linux

Now we have our web application dIl and now we need to host it on the Linux environment. First, we
need to understand how the deployment works in Linux. .Net applications run on Kestrel servers and we
run Apache or Nginx server in Linux environments, which acts as a proxy server and handles the traffic
from outside the machine and redirects it to the Kestrel server so we will have Apache or Nginx server as
the middle layer.

Here we will use Apache as a proxy server.
First, we need to install the .Net core module in our Linux environment. For that run the following
commands

sudo apt-get update

sudo apt-get install apt-transport-https

sudo apt-get update

sudo apt-get install dotnet-sdk-3.1

sudo apt-get install dotnet-runtime-3.1

sudo apt-get install aspnetcore-runtime-3.1
14



DEPLOY .NET CORE APPLICATION ON LINUX

Step 3 - Install and configure Apache Server

e So now we have all the required .Net packages. | have installed an
additional package so if you are running a different project it will help.

* Now install the Apache server,

sudo apt-get install apache2
sudo a2enmod proxy proxy_httpproxy htmlproxy wstunnel

sudo a2enmod rewrite

* Now we need to make a conf file to set up our proxy on Apache. Create
the following file:

sudo nano /etc/apache2/conf-enabled/netcore.conf

* Now copy the following configuration in that file,

15



DEPLOY .NET CORE APPLICATION ON LINUX

Now copy the following configuration in that file,
<VirtualHost *:80>
ServerName www.DOMAIN.COM
ProxyPreserveHost On
ProxyPass / http://127.0.0.1:5000/
ProxyPassReverse / http://127.0.0.1:5000/
RewriteEngine on
RewriteCond %{HTTP:UPGRADE} "WebSocketS [NC]
RewriteCond %{HTTP:CONNECTION} Upgrade$S [NC]
RewriteRule /(.*) ws://127.0.0.1:5000/S1 [P]
ErrorLog /var/log/apache2/netcore-error.log

CustomLog /var/log/apache2/netcore-access.log common
</VirtualHost>

16



DEPLOY .NET CORE APPLICATION ON LINUX

<VirtualHost *:80>

This tag defines the IP and port it will bind Apache so we will access our application from

outside our Linux environment through this Ip:Port.
Now restart the Apache server,
e sudoservice apache2 restart

e sudoapachectlconfigtest

17



DEPLOY .NET CORE APPLICATION ON LINUX

Step 4 - Configure and Start Service

* Move your dll to the defined path with the below command.

"sudo cp -a ~/release/ /var/netcore/"

o Create a service file for our .Net application

"sudo nano /etc/systemd/system/ServiceFile.service"

* Copy the following configuration in that file and it will run our application,

18



DEPLOY .NET CORE APPLICATION ON LINUX

[Unit]

Description=ASP .NET Web Application

[Service]

WorkingDirectory=/var/netcore
ExecStart=/usr/bin/dotnet /var/netcore/Application.dll
Restart=always

RestartSec=10

Syslogldentifier=netcore-demo

User=www-data
Environment=ASPNETCORE_ENVIRONMENT=Production
[Install]

WantedBy=multi-user.target

19



DEPLOY .NET CORE APPLICATION ON LINUX

o ExecStart=/usr/bin/dotnet /var/netcore/Application.dll in this line replace
Application.dll with your dll name that you want to run.

e Now start the service. Instead of the service name in the below commands use the
name of the file made above,

o sudosystemct| enable {Service Name}
o sudosystemctl start {Service Name}

e Now vyour proxy server and kestrel server is running and you can access your
application through any ip with port 80.

» To redeploy the code your need to replace the dll and stop and start your service again
through the following commands
o sudosystemctl stop {Service Name}

o sudosystemctl start {Service Name}

20



ASP.NET CORE MODULE

e The ASP.NET Core Module is a native IS module that plugs into the IIS pipeline to
either:

o Host an ASP.NET Core app inside of the IIS worker process (w3wp.exe), called the in-
process hosting model.

o Forward web requests to a backend ASP.NET Core app running the Kestrel server,
called the out-of-process hosting model.
* Supported Windows versions
o Windows 7 or later

o Windows Server 2012 R2 or later

» When hosting in-process, the module uses an in-process server implementation for IS,
called IIS HTTP Server (lISHttpServer).

* When hosting out-of-process, the module only works with Kestrel. The module doesn't
function with HTTP.sys.

21




ASP.NET CORE MODULE

In-process hosting model
o ASP.NET Core apps default to the in-process hosting model.

* The following characteristics apply when hosting in-process:

1. 1IS HTTP Server (lISHttpServer) is used instead of Kestrel server. For in-process,
CreateDefaultBuilder calls UsellS to:

Register the |ISHttpServer.

Configure the port and base path the server should listen on when running
behind the ASP.NET Core Module.

Configure the host to capture startup errors.

22




ASP.NET CORE MODULE

2. The requestTimeout attribute doesn't apply to in-process hosting.
3. Sharing an app pool among apps isn't supported. Use one app pool per app.

4. When using Web Deploy or manually placing an app_offline.htm file in the deployment,
the app might not shut down immediately if there's an open connection. For example, a
websocket connection may delay app shut down.

5. The architecture (bitness) of the app and installed runtime (x64 or x86) must match the
architecture of the app pool.

6. Client disconnects are detected. The HttpContext.RequestAborted cancellation token is
cancelled when the client disconnects.

7. In ASP.NET Core 2.2.1 or earlier, GetCurrentDirectory returns the worker directory of the
process started by IIS rather than the app's directory (for example,
C:\Windows\System32\inetsrv for w3wp.exe).
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ASP.NET CORE MODULE

Out-of-process hosting model

* To configure an app for out-of-process hosting, set the value of the <AspNetCoreHostingModel>
property to OutOfProcess in the project file (.csproj):

XMLCopy

<PropertyGroup>
<AspNetCoreHostingModel>OutOfProcess</AspNetCoreHostingModel>
</PropertyGroup>

* In-process hosting is set with InProcess, which is the default value.

* The value of <AspNetCoreHostingModel> is case insensitive, so inprocess and outofprocess are valid
values.

o Kestrel server is used instead of IIS HTTP Server (IISHttpServer).
e  For out-of-process, CreateDefaultBuilder calls UsellSIntegration to:

o Configure the port and base path the server should listen on when running behind the ASP.NET Core
Module.

o Configure the host to capture startup errors.
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DOCKER AND CONTAINERIZATION

» .NET Core can easily run in a Docker container. Containers provide a lightweight way to
isolate your application from the rest of the host system, sharing just the kernel, and
using resources given to your application. The Docker client has a CLI that you can use
to manage images and containers.

* An image is an ordered collection of filesystem changes that form the basis of a
container. The image doesn't have a state and is read-only. Much the time an image is
based on another image, but with some customization. For example, when you create
an new image for your application, you would base it on an existing image that already
contains the .NET Core runtime.

* Because containers are created from images, images have a set of run parameters
(such as a starting executable) that run when the container starts.

» Role requirements can also be expressed using the new Policy syntax, where a
developer registers a policy at startup as part of the Authorization service

configuration. This normally occurs in ConfigureServices() in your Startup.cs file.
25




DOCKER AND CONTAINERIZATION

Containers

e A container is a runnable instance of an image. As you build your image, you deploy your
application and dependencies. Then, multiple containers can be instantiated, each isolated
from one another. Each container instance has its own filesystem, memory, and network
interface.

Registries

e Container registries are a collection of image repositories. You can base your images on a
registry image. You can create containers directly from an image in a registry. The relationship
between Docker containers, images, and registries is an important concept when architecting
and building containerized applications or microservices. This approach greatly shortens the
time between development and deployment.

e Docker has a public registry hosted at the Docker Hub that you can use. .NET Core related
images are listed at the Docker Hub.
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DOCKER AND CONTAINERIZATION

Dockerfile

* A Dockerfile is a file that defines a set of instructions that creates an image. Each
instruction in the Dockerfile creates a layer in the image. For the most part,
when you rebuild the image, only the layers that have changed are rebuilt. The
Dockerfile can be distributed to others and allows them to recreate a new image
in the same manner you created it. While this allows you to distribute the
instructions on how to create the image, the main way to distribute your image
is to publish it to a registry.

Docker support in Visual Studio

 Docker support is available for ASP.NET projects, ASP.NET Core projects, and
.NET Core and .NET Framework console projects.
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Adding Docker support

* You can enable Docker support during project creation by selecting Enable
Docker Support when creating a new project, as shown.

Create a new ASP.NET Core Web Application

.NET Core ~| | ASP.NET Core 2.2 <
A~
\1 Empty Authentication
[N
An empty project template for creating an ASP.NET Core application. This template does not have any No Authentication
content in it.

Change

E API

A project template for creating an ASP.NET Core application with an example Controller for a RESTful HTTP
service. This template can also be used for ASP.NET Core MVC Views and Controllers. Advanced

Configure for HTTPS

Web Application

: : - _ o . _ . ¥'| Enable Docker Support
A project template for creating an ASP.NET Core application with example ASP.NET Core Razor Pages PP

content. (Requires Docker Desktop)

@ﬂ Web Application (Model-View-Controller) Linux
e S e e . 78




Adding Docker support

* You can add Docker support to an existing project by selecting Add > Docker Support in
Solution Explorer. The Add > Docker Support and Add > Container Orchestrator Support
commands are located on the right-click menu (or context menu) of the project node
for an ASP.NET Core project in Solution Explorer, as shown.

Add > Area...
Manage NuGet Packages.., %9 New ltem.. Cirl+Shift+A
Manage Client-Side Libraries... ] Eisting ltem... Shift+Al+A
Manage User Secrets Mew Scaffolded ltem...
Set as StartUp Project %5 Mew Folder
Debug g Container Orchestrator Support
Source Control * | 22 | Docker Support
Cut Ctrl+X *  Application Insights Telemetry...
Solution Explorer * 0 e 2 2 Client-Side Library...
f;j‘ ! "'| T'IE' T & IE'] Rename Reference...
Search Solution Explorer (Ctrl+;) y! Unload Project 5 Connected Service
k] Solution "WebAppCaore' (1 project) g e s Class... Shift+Alt+C

4 [z3) WebAppCore M Properties Alt+Enter

& Connected Services
ke Bl Mmoo
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Adding Docker support

* When you add or enable Docker support,
Visual Studio adds the following to the project:
o a Dockerfile file
o a.dockerignore file
° a NuGet package reference to the
Microsoft.VisualStudio.Azure.Containers.Tools.Targets
* The solution looks like this once

you add Docker support:

Solution Explorer

v]il-X

WA~ 0-5S TR " F=3

Search Solution Explorer (Ctrl+;)

4 Solution '‘WebApplication33' (1 of 1 project)
4 T WebApplication33
&P Connected Services
¥ Dependencies
Y Properties
9] appsettings.json
[ Dockerfile
(% .dockerignore

A v v v

A4

C* Program.cs
C* Startup.cs

A4

Solution Explorer

o
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DEPLOY YOUR ASP.NET CORE APP TO AZURE

Publish to Azure App Service

o https://docs.microsoft.com/en-us/visualstudio/get-
started/csharp/tutorial-aspnet-core-ef-step-05?view=vs-2019
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Discussion Exercise

1. What is a web server? List down the of Web Server you can find to host
ASP.NET Core Application.

2. Explain about the Hosting Models in ASP.NET Core

3. What is lIS? How can you deploy your ASP.NET Core Application on IIS
Server?

4. Write down the details steps to host ASP.NET Application on Linux.

5
6.
7

What is ASP.NET Core Module? Explain.
What is Docker and Containers.

How do you deploy ASP.NET Core app to Azure?
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